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Sweep Frequency Response Analyzer (SFRA) User Guide 

Important Notice 
This User Guide ("Guide") and the Doble® trademark are the sole property of the Doble Engineering 
Company ("Doble") and, along with the subject matter to which they apply, are provided for the 
exclusive use of Doble Users ("User") as a result of an accepted sales order or under an agreement for 
Doble test equipment and services. 

In no event does Doble assume liability for any technical or editorial errors or omissions. Doble shall in 
no event be liable for direct, indirect, incidental, or consequential damages arising out of reliance, 
inaccurate third party information or the inability of the User to use this Guide properly. 

Copyright laws protect this Guide; all rights are reserved. No part of this Guide shall be reproduced, 
stored in a retrieval system, or transmitted by any means, electronic, mechanical, photocopying, 
recording, or otherwise without written permission from Doble. 

Doble and the Doble logo are registered in the U.S. Patent and Trademark Office and are trademarks of 
the Doble Engineering Company. 

Doble is providing the information contained herein for reference purposes only. Doble makes no 
warranty or representation that the Guide will meet the User's requirements. This Guide is 
intended to provide a basic understanding and general application of the principles set forth 
herein. Comments contained herein relating to safety represent minimum guidelines, and should 
never be compromised; however, it is foreseeable that the minimum safety guidelines may be 
supplemented in order to conform to User's company safety and compliance regulations. User is 
responsible for applying the information contained herein in strict accordance with industry as 
well as User's company compliance and safety regulations. The techniques and procedures 
described herein are based on years of experience with tried and proven methods. However, the 
basic recommendations contained herein cannot embrace all conceivable test situations and there 
may be instances when Doble should be consulted directly. Doble is not responsible for the 
MISUSE OR RELIANCE ON THIS PUBLICATION, ANY OPINIONS CONTAINED HEREIN, 
OR AS A RESULT OF MODIFICATION BY ANYONE OTHER THAN DOBLE OR AN 
AUTHORIZED DOBLE REPRESENTATIVE. UNDER NO CIRCUMSTANCES WILL 
DOBLE BE LIABLE TO ANY USER FOR ANY DAMAGES, INCLUDING WITHOUT 
LIMITATION, PERSONAL INJURY OR PROPERTY DAMAGE CAUSED BY THE 
PRODUCT, ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES, EXPENSES, LOST 
PROFITS, LOST SAVINGS, OR OTHER DAMAGES ARISING OUT OF THE USE OF OR 
INABILITY TO USE THIS GUIDE. 

Warranty 

Copyright© 2008 Doble Engineering Company 
All Rights Reserved 

Equipment Limited Warranty 
Doble warrants the products that it delivers to be free from defects in material and workmanship for a 
period of one (I) year from the date shipped from the Doble facility. Equipment delivered under a 
valid and duly executed Doble Service and Equipment Agreement will be replaced as set forth in said 
agreement. 
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Software Limited Warranty 

During the one-year warranty period, Doble will repair or replace, at its option, any defective products 
or components thereof at no additional charge, provided that the product or component is returned, 
shipping prepaid, to Doble. The Purchaser is responsible for insuring any product or component so 
returned and assumes the risk of loss during shipment. All replaced products and components become 
the property of Doble. 

THIS LIMITED WARRANTY DOES NOT EXTEND TO ANY PRODUCTS WHICH HAVE 
BEEN DAMAGED AS A RESULT OF ACCIDENT, MISUSE, ABUSE, OR AS A RESULT OF 
MODIFICATION BY ANYONE OTHER THAN DOBLE OR AN AUTHORIZED DOBLE 
REPRESENTATIVE. 

EXCEPT AS EXPRESSLY SET FORTH ABOVE, NO OTHER WARRANTIES, EXPRESSED 
OR IMPLIED, ARE MADE WITH RESPECT TO THE PRODUCT INCLUDING, BUT NOT 
LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANT ABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. DOBLE EXPRESSLY DISCLAIMS ALL WARRANTIES 
NOT STATED HEREIN. IN THE EVENT THE PRODUCT IS NOT FREE FROM DEFECTS 
AS WARRANTED ABOVE, THE PURCHASER'S SOLE REMEDY SHALL BE REPAIR OR 
REPLACEMENT AS PROVIDED ABOVE. UNDER NO CIRCUMSTANCES WILL DOBLE 
BE LIABLE TO THE PURCHASER OR ANY USER FOR ANY DAMAGES, INCLUDING 
WITHOUT LIMITATION, PERSONAL INJURY OR PROPERTY DAMAGE CAUSED BY 
THE PRODUCT, ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES, EXPENSES, LOST 
PROFITS, LOST SAVINGS, OR OTHER DAMAGES ARISING OUT OF THE USE OF OR 
INABILITY TO USE TIDS PRODUCT. 

Software Limited Warranty 
Doble warrants that: (i) for a period of one hundred twenty (120) days from the date of shipment from 
Doble, the media on which the Software is furnished will be free of defects in materials and 
workmanship under normal use; and (ii) for a period of one year from the date of shipment from Doble, 
the Software will perform in substantial conformance to its published specifications. This limited 
warranty extends only to the original licensee. Licensee's exclusive remedy and Doble's entire liability 
under this limited warranty will be, at Doble's option, to repair or replace the Software, or to refund a 
pro rata portion of the purchase price. Doble makes no warranty or representation that its software 
products will meet Licensee's requirements, that the operation of the software products will be 
uninterrupted or error free, or that all defects in the software products will be corrected. 

This warranty does not apply if the software (a) has been altered, except by Doble, (b) has not been 
installed, operated, repaired, or maintained in accordance with instructions supplied by Doble, (c) has 
been subjected to abnormal physical or electrical stress, misuse, negligence, or accident, or (d) is used 
in ultra-hazardous activities. 

IN NO EVENT WILL DOBLE BE LIABLE FOR ANY LOST REVENUE, PROFIT, OR DATA, 
OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE 
DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY 
ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE, EVEN IF 
DOBLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. In no event shall 
Doble's liability to Licensee, whether in contract, tort (including negligence), or otherwise, exceed the 
price paid by Licensee. The foregoing limitations shall apply even if the above-stated warranty fails of 
its essential purpose. 
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Limitation of Remedies 
Doble's entire liability and Purchaser's exclusive remedy shall be: 

I. The replacement of any disks not meeting Doble's "limited warranty" which are returned to 
Doble. 

2. If Doble is unable to deliver replacement disks which are free from defects in materials and 
workmanship, Purchaser may terminate the license by returning, destroying or deleting the 
sofrware product and all copies thereof in any form and affirming compliance with this 
requirement in writing, Doble will refund the purchase price. 

THE FOREGOING WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU 
OF ALL OTHER WARRANTIES, TERMS, OR CONDITIONS, EXPRESS OR IMPLIED, 
WHETHER ALLEGED TO ARISE BY LAW, BY REASON OF CUSTOM OR USAGE IN THE 
TRADE, OR BY COURSE OF DEALING, INCLUDING WARRANTIES, TERMS, OR 
CONDITIONS OF MERCHANT ABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
SATISFACTORY QUALITY, CORRESPONDENCE WITH DESCRIPTION, AND 
NONINFRINGEMENT, ALL OF WHICH ARE EXPRESSLY DISCLAIMED. 

For equipment maintenance, contact: 
Customer Service Manager (Extension 2921) 
Doble Engineering Company 
85 Walnut Street 
Watertown, MA 02472-4037 (USA) 
Telephone: 617-926-4900 
Fax: 617-926-0528 
Email: customerservice@doble.com 
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1. Introduction 

The M5200 (Figure 1.1 ), M5300 (Figure 1.2), and M5400 (Figure 1.3) Sweep Frequency 
Response Analyzers measure and record the frequency-response characteristics of transformer 
windings. They accomplish this using a rugged field instrumentation/ controller module, an 
excitation source, and a measurement module, packaged in a robust molded shell. 

r-·-----: 
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Figure 1.1 M5200 SFRA 

Figure 1.2 M5300 SFRA 
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Figure 1.3 M5400 SFRA 

Sweep Frequency Response Analysis (SFRA) testing has become a valuable tool for verifYing 
the geometric integrity of electrical apparatus, especially transformers. SFRA provides 
internal diagnostic information using nonintrusive procedures (Figure 1.4). The SFRA test 
method has been proven to provide accurate and repeatable measurements, with Doble 
furnishing the support to extract value from the measurements. 

TbreeBNC 
Color-Coded Connectors 

'-----------" © 

Safety Ground 

Figure 1.4 M5300 Connections (M5200 and M5400 Similar) 

Power transformers are specified to withstand the mechanical forces arising from both 
shipping and subsequent in-service events, such as faults and lightning. Transportation 
damage can occur if the clamping and restraints are inadequate; such damage may lead to core 
and winding movement. The most severe in-service forces arise from system faults and are 
axial and radial in nature. If the forces are excessive, radial buckling or axial deformation can 
occur. With a core form design, the principal forces are radially directed, whereas in a 
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shell-form unit, they are axially directed. This difference is likely to influence the types of 
damage found. 

Once a transformer is damaged, even if only slightly, its ability to withstand further short 
circuits is reduced. Utility personnel need to effectively identify such damage. A visual 
inspection is costly and does not always produce the desired results or the correct conclusion. 
During a field inspection, the oil has to be drained, and confmed-entry rules apply. Since so 
little of the winding is visible, little damage can be seen, other than displaced support blocks. 
Often, a complete teardown is required to identify the problem. An alternative method is to 
implement field-diagnostic techniques capable of detecting damage. 

There is a direct relationship between the geometric configuration and the distributed 
electrical elements, otherwise known as RLC networks, of a winding and core assembly. This 
RLC network can be identified by its frequency-dependent transfer function. Frequency 
Response Analysis testing can be accomplished by the sweep frequency method. Changes in 
the geometric configuration alter the impedance network, and in turn alter the transfer 
function. Changes in the transfer function reveal a wide range of failure modes. 

The primary objective of SFRA is to determine how the impedance of a test specimen behaves 
over a specified range of frequencies. The impedance is a distributive network of real and 
reactive electrical components. The components are passive and can be modeled by resistors, 
inductors, and capacitors. The reactive properties of a given test specimen depend on, and are 
sensitive to, changes in frequency. The change in impedance versus frequency can be dramatic 
in many cases. This behavior becomes apparent when we model impedance as a function of 
frequency. The result is a transfer function representation of the RLC network in the frequency 
domain. 

Frequency response analysis is generally applied to a complex network of passive elements. 
For practical purposes, we will consider only resistors, inductors, and capacitors as passive 
circuit elements, and they are assumed to be ideal. These three fundamental elements are the 
building blocks for various physical devices, such as transformers, motors, generators, and 
other electrical apparatus. 

It is important to understand the difference between the physical device and the mathematical 
model we intend to use. When large and complex systems are electrically analyzed, we are 
often faced with a poorly defmed distributed network. A distributed network contains an 
infinite number of infinitely small RLC elements. For example, transmission lines are 
generally distributed in nature. 

It is practical to model such distributed systems by lumping the basic RLC components 
together, resulting in a lumped network. Lumping elements together for a single frequency is a 
trivial task, but when system modeling requires spanning a significant frequency interval, 
producing a suitable lumped model becomes difficult. 

When a transformer is subject to SFRA testing, the leads are configured to use four terminals. 
These four terminals can be divided into two unique pairs--one pair each for the input and 
output. These terminals can be modeled in a two-terminal pair or a two- port network 
configuration (Figure 1.5). 
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Figure 1.5 Two-Port Network 

Solving for the open-circuit impedance for each lumped element forms the impedances Zll, 
Z22, Zl2, and Z21. It should be noted that the negative terminals are short- circuited when 
transformers are tested. The transformer tank is common for both negative and lower 
terminals. The transformer tank and lead ground shields must be connected together to achieve 
a common-mode measurement. This assures that no external impedance is measured. 
Applying the connection in this manner helps reduce the effects of noise. It is important to 
obtain a zero impedance between the lower or negative terminals to assure a repeatable 
measurement. 

The transfer function of an RLC network is the ratio of the output and input frequency 
responses when the initial conditions of the network are zero. Both magnitude and phase 
relationships can be extracted from the transfer function. The transfer function helps us better 
understand the input/output relationship of a linear network. The transfer function also 
represents the fundamental characteristics of a network and is a useful tool in modeling such a 
system. 

The transfer function is represented in the frequency domain and is denoted by the Fourier 
variable H(jw), where (jw) denotes the presence of a frequency-dependent function, and w= 
2rrf The Fourier relationship for the input/output transfer function is given by: 

v (jOJ) 
H(j OJ) = output 

vinput(jOJ) 

When a transfer function is reduced to its simplest form, it generates a ratio of two 
polynomials. The main characteristics, such as half-power and resonance, of a transfer 
function occur at the roots of the polynomials. 

The goal of SFRA is to measure the impedance model of the test specimen. When we measure 
the transfer function H(jw), it does not isolate the true specimen impedance 
Z(jw). The true specimen impedance Z(jw) is the RLC network, which is positioned between 
the instrument leads, and it does not include any impedance supplied by the test instrument. 

It must be noted that when using the voltage relationship, H(jw) is not always directly related 
to Z(jw). For Z(jw) to be directly related to H(jw), a current must be substituted for the output 
voltage and then Ohm's Law can be realized. However, SFRA uses the voltage-ratio 
relationship to determine H(jw). Since SFRA uses a 50-ohm impedance- match measuring 
system, the 50-ohm impedance must be incorporated into H (jw). The next equation shows the 
relationship of Z(jw) to H(jw): 
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50 

Z(jm) +50 

It is often useful to plot the magnitude and phase relationship of the transfer function in 
logarithmic format. The units of magnitude and phase are in decibels (dB) and degrees, 
respectively. Magnitude and phase are represented as follows: 

A(dB) = 20 log 10 <HUm)) 

A(B) = tan-1<HUm)) 

This format takes advantage of the asymptotic symmetry by using a logarithmic scale for 
frequency. Plotting the phase relationship with the magnitude data helps determine whether 
the system is resistive, inductive, or capacitive. It is often useful to compare resonance in the 
magnitude plots with the zero crossings in the phase relationship. 

Accessories 

NOTE 

[[J 

Test Cables 
The cables and connectors supplied with the M5000 instruments are made from low- loss 
RG-58 RF coaxial cable, with the shields grounded to the instrument chassis through a 
standard connector. The instrument requires a matched impedance signal cable and performs a 
single-end measurement-that is, the signal is measured with respect to the instrument 
ground. The shield of the signal cable must be connected to the chassis using a 50-ohm 
impedance-matched RF BCN connector. The test leads should not be modified in any manner. 

Practical field experience indicates that the leads be 60 ft I 18 m. This is the shortest length 
useful to test the largest transformers from a location on the ground, adjacent to the unit. 
Nevertheless, lead length determines the maximum effective frequency. 

The standard cable shield grounds connect the cable shields to the transformer ground at the 
base of the bushing. These ground connections are 12 ft I 3.6 m back from the terminal 
connection, on the measurement ends of the cables. If this is not enough to reach from the 
bushing terminal to the base of the bushing, a I 00 foot I 30 m cable is available, with ground 
connections 18ft I 5.4 m back from the terminal connection (Table 1.1). 

The longer cable should should be purchased only as an accessory and should not be 
used in place of the standard cable iftbe standard cable can be applied. The decision on 
which cable to use should consider only bushing height, and the cable should be 
consistent from test to test. 
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Table 1.1 SFRA Test Cables 

Standard Optional 

Length 60ft/ 18m 100ft I 30m 

Trunk 50 I 50 (30ft I 9 m) 45 I 55 (55ft /16.5 m) 

Ground 80 I 20 (12ft I 3.6 m) 82/ 18(18ft/5.4m) 

Application ~ 362 kV > 362 kV 

Large Cable Clamps 
These clamps connect to larger bushing studs or terminals where the normal connectors do not 
fit. The standard test cables then clip to the large clamps. 

Instrument Safety/Chassis Ground 
Grounding of signal cable shields, specimen, and instrument chassis is important to achieving 
a reproducible result. The safety ground (Figure 1.6), also known as the instrument-chassis 
ground, connects the instrument chassis to the transformer ground. 

Figure 1.6 Safety Ground 

The M5200 and M5400 are controlled by a user-supplied laptop computer running Doble 
SFRA software (supplied with the instrument). The M5300 comes with a built-in PC, laptop 
keyboard, and preinstalled Doble SFRA software. Doble SFRA software is discussed in 
Chapter 2. 

Safety and Personnel 

1-6 

Safety cannot be overemphasized when workiog on or around high-voltage electrical 
apparatus. Companies that generate, transmit, distribute, or use high-voltage electricity should, 
and do, have precise rules for safe practices and procedures. These practices are important for 
personnel whose working responsibilities involve testing and maintaining high-voltage 
apparatus and its associated lines, cables, conductors, and accessories. 
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General Rules 

General Rules 
1. The transformer under test should be completely de-energized and isolated from the 

power system before performing any tests using an MSOOO-series SFRA instrument. 

2. The method of testing a high-voltage apparatus (transformer) involves exciting the 
apparatus with the SFRA instrument. Take care to avoid contact with the apparatus 
being tested, its associated bushings and conductors, and the SFRA instrument's 
cables and connectors. 

3. The test crew must make a visual check to ensure that the apparatus terminals are 
isolated from the power system. Because the apparatus under test may fail, take 
precautions (such as barriers or entrance restrictions to the test area) to avoid harm in 
case of violent failure. 

4. All of your company rules for safe practice in testing must be strictly conformed to, 
including all practices for tagging and isolating apparatus during testing and 
maintenance work. State, local, and federal regulations, e.g., OSHA, may also apply. 

Company rules and government regulations take precedence over Doble 
recommendations. 

Personal protective equipment suitable for electrical testing of transformers is 
recommended. 

Grounding 
The apparatus under test, its tank or housing, and the SFRA instrument must be solidly and 
commonly grounded or earthed. This also applies to any mobile equipment being tested. 
Figure 1. 7 shows a sample safety ground connection. 

Figure I. 7 Connecting Safety Ground to Transformer 

The instrument test-cable shields must also be grounded or earthed to the same common point 
as the instrument. This is usually achieved by attaching the grounds securely to the bushing 
flange base. 
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Proper grounding is important for safety and for reliable SFRA test results. 

Personnel 
1. A pretest meeting is recommended. Frequently, other crews will be working on 

non-test-related tasks in close proximity to equipment being tested. The pretest 
meeting should include all personnel who will be working in proximity to the area 
where testing will be performed. In this meeting, review with crew members the tests 
to be performed, apparatus, voltage test levels involved, potential hazards, and 
individual assigmnents. Test personnel need to remain aware of the work activity 
taking place around them and alert to the possibility that non-test personnel may enter 
the test area. 

2. Agree on a consistent and uniform set of signals, both visual and verbal. All crew 
members should follow them during testing. 

3. While making the various types of connections involved in the tests, it may be 
necessary for personnel to climb up on the apparatus, but no one should remain on the 
apparatus during the test itself. 
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2. Software 

The MSOOO instruments come with intuitive, Windows-based SFRA software (Figure 2.1) that 
runs on a standard PC supplied by the user (for tbe M5200 or M5400) or on the M5300 itself. 
The software allows you to make and compare SFRA measurements. The test is easy to 
perform, but recording all relevant details for future reference is important; otherwise, it 
becomes difficult to reproduce test results. 

Spe<:ioiiD 
.. : ,-_.-~ ··, 

.,. .. .. . 
Fr"q I 

Manu 

I 
Sl'r# 

Spccl~l 

'"' 
~VA 

v. 

. 
), ' 
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Figure 2.1 SFRA Software Main Screen 

The software requires a minimum set of details before taking a measurement: 

Test location 

• Testing organization 

• MSOOO instrument serial number 

• Transformer manufacturer 

• Transformer serial number 

• Red lead location 

• Black lead location 
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You can set up and save basic information before performing tests. Templates of tests are 
available, witb different transformer designs. All traces are automatically saved upon 
completion. 

Installing SFRA on a PC for M5200 or M5400 

Title Bar 

2-2 

Doble SFRA software is loaded on your PC using standard software load procedures. As part 
oftbe load, tbe Microsoft .NET framework 2.0 is installed on your machine if it is not already 
present. 

Do not install tbe software to a network drive or to an image of a network drive-these will 
not be available in tbe field, and data will not save. 

When testing in tbe field using an M5200 or M5400, the PC witb the software installed should 
not be connected to any otber network and should not have a wireless network enabled (or 
switched on). Disable firewall and virus software while making measurements. These may be 
returned to default settings when using tbe software as a viewer only and not communicating 
with the M5200 or M5400. 

PC Requirements 
Minimum requirements for the PC used witb the M5200 or M5400 are: 

• Processor: 500 MHz 

• Operating system: Windows 2000 or XP 

• RAM: 256MB 

• Hard-drive free space: 20 MB for application 

• Communications: Ethernet crossover cable and USB cable included with M5200 and 
M5400 

Crossover Cable 
Connect the PC running SFRA software to the M5200 or M5400 using tbe crossover cable 
included witb the instrument. A standard network cable witbout a crossover adapter will not 
allow communication. 

The title bar (Figure 2.2) displays the Doble logo and tbe title Doble Sweep Frequency 
Response Analyzer. Click on the logo to access a dropdown menu tbat includes: 

• Restore 

• Move 

• Size 

Minimize 

• Maximize 

• Close 
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Restore 

Minimize 

X Close 

Figure 2.2 Title Bar 

Status Bar 
Figure 2.3 shows the status bar at the bottom of the maio screen. The status bar displays the 
blue and red cursor coordioates of a graph on the Magnitude, Phase, or Impedance tab. The 
coordioates reflect the last change you made to the cursor position on any of the three tabs. 
Click the blue or red "+" sign to show or hide the cursors. The field on the right (active only 
when both are on) displays the difference between the two. 

'L. + m_m:~o~i89~)L_ ___ :gB25k. 0.038 

Figure 2.3 Status Bar 

Menu Bar 
Each item io the menu bar (Figure 2.4) is discussed below. Menu bar options are disabled or 
grayed out if they are not available in the current tab. 

Figure 2.4 Menu Bar 

File 
File menu (Figure 2.5) items are: 

Print Ctrl+ P 

Print Preview Ctri+Shift+P 

EHit 

Figure 2.5 File Menu 

The File menu has no Save command, because all traces are automatically saved upon 
completion. 

Print. Opens the standard Wiodows Print dialog box. Shortcut key: Ctrl + P 
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Print Preview. Previews the print fonnat for the plot shown on the Magnitude tab. Click the 
up or down arrow at the upper right comer of the Preview window (to the right of the Page 
field) to view each page. Shortcut key: Ctrl + Shift + P 

Exit. Exits the program. Shortcut key: Alt + F4 

Edit 
Edit menu (Figure 2.6) items are: 

~j Edit ,Apparatus 

:J Options 

Figure 2.6 Edit Menu 

Edit Apparatus. Opens the Test Equipment Editor dialog box (Figure 2.22), allowing you to 
enter or edit apparatus, location, and company details. 

Options. Opens the Sweep Frequency Response Analyzer Settings dialog box (Figure 2.35), 
allowing you to change the default location of data, lists, and the template file. 

Test Init 
Test Init menu (Figure 2. 7) items are: 

1. · ...• 
... !~.~.~--~~~~_,J··Graph ·_ · He1p:.,:· : :, __ 

Select Ppparatus 

Figure 2. 7 Test /nit Menu 

Select Apparatus. Opens the Apparatus Selection dialog box (Figure 2.29), allowing you to 
select an apparatus for a test. 

Start Test. Starts a test. Active only after you use Select Apparatus to choose an 
Apparatus/Location combination. 

Graph 
Graph menu (Figure 2.8) items are shown below. 

To pan a graph, press Control and use the left mouse button to drag the trace across the screen. 
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Graph 

G!~Pb.J H~lp. ···•·•· •·· · .. ·.· .•. · .• · ..• ·· · ..•.. · ..... 

El 

C~,.~rsor1 Ctr1+1 

Cursor2 Ctrl+2 

Center Cursors 

Zoom 

Un2oom 

New Range Ctri+R 

Log 
Linear 

Clear Traces 

Ctrl+ 1 

Ctr1+2 

Ctri+R 

Figure 2.8 Graph Menu 

Cursor 1. Displays a blue crosshair cursor on the Magnitude, Phase, or Impedance graph. You 
can also click the blue "+" field in the status bar to activate the cursor. Coordinates appear in 
the blue "+" field of the status bar. The cursor attaches to the nearest graph. Click and drag 
either cursor line to move it. 

Cursor 2. Displays a red crosshair cursor on the Magnitude, Phase, or Impedance graph. You 
can also click the red "+" field in the status bar to activate the cursor. Coordinates appear in 
the red "+" field of the status bar. The cursor attaches to the nearest graph. Click and drag 
either cursor line to move it. 

Center Cursors. Centers the cursor crosshairs in the graph. This is the center of the scale 
values, which may be offset on a log scale. 

Zoom. Zooms on the graph section between cursor positions. Both cursors must be visible. 
Shortcut key: Shift+ click. You can also shift, click, and drag diagonally to create a rectangle 
outlining the area you wish to zoom on. 

Unzoom. Resets the graph to the default view. 

New Range. Opens the Plot Range dialog box (Figure 2.8), allowing you to set the low and 
high axis limits. This is useful when producing zoomed plots of graph areas for reports. 

Log. Displays the graph with a log x-axis scale. This typically emphasizing lower frequencies. 

Linear. Displays the graph with a linear x-axis scale. This typically emphasizes higher 
frequencies. 
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Enter low and High his lirits 

L.ow-XAxis High-XAHis 

135220 :±l Frequency, Hz 177244 :±l 

1·42 :±l Magnitude.. dB l-17 :±l 
L..ow-VAxis High-VAH:is 

1·180 :±l Phase, Oeg pso :±l 

Restore Defaub 

OK Cancel 

Figure 2.9 Plot Range Dialog Box 

Clear Traces. Opens the Clear Traces dialog box (Figure 2.1 0), allowing you to remove one 
or more traces from the display. Check the boxes of the traces you wish to remove and click 
OK. 

Clearing traces is different from checking or unchecking boxes in the Legend pane, which 
leaves the trace there but merely shows or hides it on the tab. Clearing the trace here removes 
it from the Legend pane. 

lif Cl;ar T[<!ces _ .~~~-~-
--··---·-·---

Clear Trace Options 

[j X1·X0_2006-10-22_16·39·44_Smooth "'-• 
L::: X1-X0_2006·10-22_16-39·44_Smooth 
0 X2-X0_2006-10-22_16-42-20_Smooth ·· 
U X3-X0_2006-10-22_16-45-17_Smooth c. 

1 
[J H1-H2_2006-1 0-22_16-50-16_Smooth I 
[J H2-H3_2006·1 0-22_16-52-33_Smooth 1' 

0 H3-H1_2006·1 0-22_16-54-41_Smooth v I 

Select All I Unselecl All j ! 
---_-' _________________ ! 

OK Cancel 

Figure 2.10 Clear Traces Dialog Box 

Help 
Help menu (Figure 2.11) items are: 
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Help. Opens the help file. 

Help 

.About 

Figure 2.11 Help Menu 

Apparatus/Test and Legend Panes 

About. Opens the version information and copyright dialog box. The software version and 
build number are in the upper right corner. If you are connected to an instrument or are using 
an M5300, the Instrument Firmware Information field displays the instrument firmware 
version and related information, which may be useful in diagnostic situations. Scroll down to 
reach the firmware version. 

Apparatus/Test and Legend Panes 
Click the appropriate tab at the lower left of the screen to display either of these panes. 

Apparatus and Test Pane 
Use the Apparatus and Test pane at the left of the main screen to select a transformer for test, 
set basic test parameters, and start a test. Subsequently, this pane shows which frequency is 
being measured and the progress of the test. When using an M5200 or M5400, this pane is 
active only when connected to the instrument. 

Legend Pane 
The Legend pane allows you to show or hide graphs on the Magnitude, Phase, and Impedance 
tabs and to set their properties. Check or uncheck the box at the left of the graph name to show 
or hide the trace. Right-click on a trace name and click Plot Property to display the Plot 
Property dialog box (Figure 2.12). 

Use the dropdown menus to change the color, line style, and width of the plot. Interference 
Cancellation filters the results if they contain noise. It applies only to plot views and does not 
alter the saved data. Leave it checked unless you need to identify noise frequencies within the 
results. This option is not available with results from M51 00 version l.x or 2.x software. 
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Color 

Line Style 

I= solid 3 
Width 

12 iJ 

P Interference Cancelation 

OK Cancel 

Figure 2.12 Plot Property Dialog Box 

Data Manager Tab 
The Data Manager tab (Figure 2.13) displays test files grouped by folders (default or 
user-defmed), with controls to select, display, and export those files . 
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Magnitude Tab 

Magnitude Tab 
The Magnitude tab (Figure 2.14) displays magnitude versus frequency for tbe selected 
graph(s). 

·•-
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Figure 2.14 Magnitude Tab 

Phase Tab 
The Phase tab (Figure 2.15) displays phase versus frequency for the selected graph(s ). Phase is 
rarely used but can occasionally be useful when looking at whether a measurement is more 
inductive or more capacitive. 
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Impedance Tab 
The Impedance tab (Figure 2.16) displays Impedance (Z Ohms) and Admittance (Y Mhos) 
representations, using the magnitude and phase results for calculation. Use the option button at 
the lower left to select the desired display type. 

/ ... ~ . .,...__;~,,~~J,""""' .. !~I .. $\b:l!loi<I.LW~.I;c~.,~J,J~d.,.'-"""·1 
lE•OS-

.... 
~ 

. i ·~-.-

··-
'" 

,, 

Figure 2.16 Impedance Tab 

Sub-Band Tab 
The Sub-Band tab (Figure 2.17) is included for historical continuity. Early work on SFRA 
required results displayed on graphs of 2 kHz, 20 kHz, 200 kHz, and 2 MHz. The last three of 
these are included here to permit viewing those graphs. 

). 

·" 
..0-i 

l[(tl' ltH: '"" 
.,, 

• <0-

... 
nl-1, 

·~· 
---' -·· ---·- ·--·" - -" --·---· ----·--··-

. ~ 
Figure 2.17 Sub-Band Tab 
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Waveform Tab 

Waveform Tab 
The Waveform tab (Figure 2.18) is useful when monitoring the progress of a measurement: it 
displays both the reference waveform generated by the test set and the measured waveform of 
the object under test. This tab displays a waveform only when a test is in progress. 

It is also possible to use the Waveform tab to help diagnose a bad connection, which will 
appear as a low, noisy, nonsinusoidal signal. 

/oDocoH..,. __ L~-1-FWo.(,~_( .. slbelnj( __ ~~--J ~ 1- T.war;;.,j,Awoo .... f 
·-
·-
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·•-

10 12 I( 16 18 ,0 2:' 2j t6 ;.>B ~ :U l4 :tr, ~ J. ~2 1.., 1r, k o;U 

''""'·"" 
Figure 2.18 Waveform Tab 

Analysis Tab 
The Analysis tab (Figure 2.19) allows you to compare two traces. The upper pane displays the 
two traces you select; the lower pane displays the difference between them . 

./._ ,D&""'--.1• "'a,;n~Wo.J Ft.>:o.(,_I~.J ... S~.;(,.:W....,<;i,.Mfi1 . .U,kt.oWoto;>J, .._,"""'_J-
0· 

~-

•· 

·-• 
I ·--------------------~ ' 

·10-

!100-· li:®i;3 Jloo:il"' fi:~~ ~-- ~"foo:oo-

Con ....... [OS393 ~ [0.5m [O.'H/0 ~ 
f;ooll_.. Dan41 D.....t~ Bond3 Dand. llond5 

Figure 2.19 Analysis Tab 
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Tabulation Tab 
The Tabulation tab (Figure 2.20) displays graph data in tabular form. Check a box in the 
Legend pane to display the values for that graph. 

Figure 2.20 Tabulation Tab 

Apparatus Tab 
The Apparatus tab (Figure 2.21) displays test setup, apparatus location, and transformer 
nameplate information related to the trace selected in the Legend pane. 

Figure 2.21 Apparatus Tab 
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Test Equipment Editor for Nameplate Data 

Test Equipment Editor for Nameplate Data 
The Test Equipment Editor (Figure 2.22) allows you to create, edit, review, and delete 
nameplate details for tests. 

To open the Test Equipment Editor, select Edit > Edit Apparatus. The three editing panes 
(Location, Test Equipment, and Test Organization) all work the same way: select the desired 
item in the list on the left; details appear in the fields on the right. 

Location LJst 
New location 

New Location 

lmportFrom I 
Location File 

Ted Equipment list---

New Serial Number 

Now 

·· ~-- .. --·Location··-­

] location 

Delete 
Location 

Export To 
location File 

Delete 

,J 

i !New Location 

: Ba ld 

: Notes 

. 

:"Test Equipment-­
Seri.:~l Number 

!New Serial Number 

Calibration Date 

I Saturday . January 01. 2000 

Notes 
Equipment Equipment 

Test Organization list·-· ---- ,--Test Organization 

New 
Organization 

Delete 
Organization 

' Company 

' !New Company 

Companyld 

' Operator 

Notez 

Figure 2.22 Test Equipment Editor 

Edit 
Transformers 

Ed itT emplates 

Save and Exit 

Cancel and Exit 

• Location is a uniquely identifiable place where the transformer SFRA test takes place. 
Each entry must have a unique name; this is its key identifier. 

• Test Equipment is an M5000 test set, uniquely identified by its serial number. 

• Test Organization is the organization performing SFRA testing. 

Creating 
To create a new entry: 
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1. Click the New button for the appropriate category on the left. 

A new entry (e.g., New Location) appears in the list. 

2. Enter data in the fields on the right, or edit existing data. 

3. Click Save And Exit. 

Editing 
To edit nameplate data: 

1. Select the desired item in the appropriate category on the left. 

2. Edit the contents of the fields on the right. 

3. Click Save And Exit. 

Deleting 
To delete nameplate data: 

1. Select the desired item in the appropriate category on the left. 

2. Click the Delete button for that category. 

The Confirm Delete dialog box appears. 

3. Click Yes. 

4. Click Save And Exit. 

Deleting an entry does not delete any results associated with that entry. 

Importing and Exporting Location Files 
SFRA software allows you to import and export Location files. This helps ensure consistency 
of locations for different users. The files are saved in .xml format. 

To export a Location file: 

1. Select the location in the Location List. 

2. Click Export To Location File. 

The Save As dialog box appears. 

3. If desired, enter a new filename in the File Name field. 

4. Click Save. 

To import a Location file: 

1. Click Import From Location File. 

The Open dialog box appears. 

2. If necessary, navigate to the appropriate folder on your computer. 

3. Select the file. 

4. Click Open. 

The Import From Location dialog box appears. 

5. Click OK. 
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Transformer Editor 

Transformer Editor 
The Transformer Editor (Figure 2.23) allows you to create, edit, review, and delete 
Transformers. A transformer is any uniquely identifiable test object. It is, in fact, a 
complicated object consisting of many parts and subassemblies: coolers, bushings, tap 
changers. The transformer editor allows you to enter relevant information. 

Transformers are not tied to particular locations-Transformers and Locations are combined 
when you test, so that a test is performed on a transformer at a particular location. The location 
may change on subsequent tests-after relocating the transformer, for example. 

To open the Transformer Editor, first open the Test Equipment Editor, then click Edit 
Transformers. Available transformers appear in the left pane. The Transformer Editor has 
three tabs: 

• Transformer 

• LTC/DETC 

Test Template 

Each tab allows access to data related to a particular transformer. Each can be edited 
independently. 

Transformer Tab 
The Transformer tab (Figure 2.23) allows you to enter or edit nameplate data for a 
transformer. 

Creating 
To create a new transformer: 

1. Click New. 

A New Serial Number appears in the Transformer List. 

2. Select a manufacturer from the dropdown menu on the Transformer tab. This is a 
required field. If the manufacturer name is not available, select (No MFR Listed). 

3. Enter the serial number of the transformer. This is a required field. Each transformer 
must have a unique serial number; this is its key identifier. 

4. Enter any other desired data on the Transformer tab, or edit existing data. 

5. Click OK. 
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Figure 2.23 Transformer Editor- Transformer Tab 

Editing 
To edit a transformer: 

1. Select the transformer in the Transformer List. 

2. Edit the contents of the fields on the Transformer tab. 

3. Click OK. 

Cloning 
Cloning duplicates an existing transformer, so you can create a new entry without having to 
reenter all the data. The only required new field is the serial number. 

To clone a transformer: 

1. Click Clone. 

The Edit Serial Number dialog box appears (Figure 2.24). 

2. Enter a new serial number. 

3. Click OK. 

4. Make any other necessary edits on the Transformer Editor tabs. 

5. Click OK. 
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OK Cancel 

Figure 2.24 Edit Serial Number Dialog Box 

Deleting 
To delete a transformer: 

1. Select the transformer in the Transformer List. 

2. Click Delete. 

The Confirm Delete dialog box appears. 

3. Click Yes. 

4. Click OK. 

Deleting a transformer does not delete any results associated with that transformer. 

Importing and Exporting Transformer Files 
SFRA software allows you to import and export Transformer files. This helps ensure 
consistency for different users. The flies are saved in .xml format. 

To export a Transformer file: 

1. Select the transformer in the Transformer List. 

2. Click Export To Transformers File. 

The Save As dialog box appears. 

3. If desired, enter a new filename in the File Name field. 

4. Click Save. 

To import a Transformer file: 

1. Click Import From Transformers File. 

The Open dialog box appears. 

2. If necessary, navigate to the appropriate folder on your computer. 

3. Select the file. 
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4. Click Open. 

The Import From Transformers File dialog box appears. 

5. Click OK. 

LTC/DETC Tab 
The LTC/DETC tab (Figure 2.25) allows you to enter data associated with any load tap 
changer (LTC) or de-energized tap changer (DETC) that may be present on the transformer. 
This is not required but is useful reference data. 

The Range fields are used to indicate the full range available for the LTC or DETC. 

The position of the tap changer during a test is recorded in a separate table when a test is made. 

New 

Delete 

Import from I 
Trans:ers 

,--LTC-·--------- -- ---------

Serlo! Nvrnber ~nufadurer Year 

I .. ..,. 
I I lc____l 

f'--om ____ __j 

' Manufacturer Se<'tal N~ Mill<.h<;turer Year 

I lt:•• ____ _j 

'""' 
i I 

OK cancel 

. 

• 

• 

Figure 2.25 Transformer Editor- LTCIDETC Tab 

Test Template Tab 
A transformer may have a test template associated with it (see "Test Templates" on p. 2-19), 
which allows you to identifY and name a collection of tests-for example, for a three-phase 
autotransformer. On the Test Template tab (Figure 2.26), you can associate these tests with a 
transformer. 

A test template provides a list of recommended tests for a transformer but does not constrain 
you to particular tests. It is a guide rather than a constraint. 
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Figure 2.26 Transformer Editor- Test Template Tab 

To associate a test template with a transformer: 

1. Select the transformer in the Transformer List. 

2. Click Select in the right pane. 

The Template Editor appears (Figure 2.27). 

3. Select an existing template in the Template List or create a new template and select it 
(see the next section). 

4. Click OK twice. 

Test Templates 
The Template Editor (Figure 2.27) allows you to create, edit, review, and delete test templates. 
Test templates are a means of grouping tests for a particular transformer design and are a 
flexible way to specifY tests for use in the field. You can associate a template with a number of 
transformers or create it for future reference and not associate it with any transformer. 

SFRA software comes with preconfigured templates, in the Settings folder. You can edit these 
files or replace them. (Back up data before replacing a file.) You can import other templates 
using a simple procedure to merge template files (see "Merging Settings Files" on p. 2-33). 

A template is a guide and not a constraint. You can select tests from the template, specifY tests 
that are not in the template, or ignore the template reconunendations. 
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Figure 2.27 Template Editor 

To open the Template Editor from the Test Equipment Editor, click Edit Templates. To open 
the Template Editor from the Template tab of the Transformer Editor, click Select. 

Creating 
To create a new test template: 

1. Click New. 

A New Template appears in the Template List. 

2. Enter a name in the Name field (required) and a description if desired. 

3. Click Manage, or right-click a row or heading of the Test Settings table and click 
Manage. 

The Test Setting Editor appears (Figure 2.28). 

4. Enter the appropriate settings. Red Lead and Black Lead are required. 

5. Click OK. 

Editing 
To edit a test template: 

1. Select the template in the Template List. 

I 
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Deleting 

2. Click Manage, or right-click a row or heading of the Test Settings table and click 
Manage. 

The Test Setting Editor appears (Figure 2.28). 

3. Edit the contents of the fields on the right. 

4. ClickOK. 

Deleting 
To delete a test template: 

1. Select the template in the Template List. 

2. Click Delete. 

The Confirm Delete dialog box appears. 

3. Click Yes. 

4. Click OK. 

Managing Tests in a Template 
The Test Setting Editor (Figure 2.28) allows you to add, edit, or delete tests in a template. 

~.[e~t~<>J!il!ll!<!i!Q~~ 
Test Setting List----, 'Test Setting ""~-~ .. "--·-··----, 

i ' Red le<ld Black Lead 
H2.HO 

i ' IHl I IHD I i H3.HO : XlXO 
X2XO LTC Postion DETC Position 
X3XO le~<treme raise I las lound ·make note I Hl.HO 
H2.HO Terminal Shmted Terminal Grounded 

i H3.HO ! 
!none I I none I ' 

I' i 
' New 

i 

! 
Measurement Type 

Delete II j OpenCircuit ~ ! .. -------·~-----·-

I OK I Cancel I 
Figure 2.28 Test Setting Editor 

To open the Test Setting Editor from the Template Editor, click Manage, or right-click a row 
or heading of the Test Settings table and click Manage. 

The name of each available test appears in the Test Setting List. The minimum required 
information is the position of the red lead (e.g., HI, A, or N) and the black lead (e.g., XO, n, or 
v). Together, these values provide the name of the test in the Test Setting List. 

Creating 
To create a new test setting: 

1. Click New. 
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New Red,New Black appears in the Test Setting List. 

2. Enter the appropriate settings. Red Lead and Black Lead are required. 

3. Click OK. 

Editing 
To edit a test setting: 

1. Select the test in the Test Setting List. 

2. Edit the contents of the fields on the right. 

3. Click OK. 

Deleting 
To delete a test setting: 

1. Select the test in the Test Setting List. 

2. Click Delete. 

The Confirm Delete dialog box appears. 

3. Click Yes. 

4. Click OK. 

Running a Test 

2-22 

You can perform a test only with an M5300 or with a PC connected to an M5200 or M5400; it 
is not possible to perform a test in Viewer mode without an instrument. 

To run a test: 

Select Apparatus 
1. Click Select Apparatus in the Apparatus And Test pane. 

The Apparatus Selection dialog box appears (Figure 2.29). 

,,_..,..,.,.,,.,..,..,.,....,..,...~-,...,-,.><C~~"~-··~""""~-~~-~-=~~~~"-"-~-~~---~----~~--~~~~~---

Appar~tusSelection ,,, ~ ~ ~ ,.,~ ~-, ~ ~~ 

Select Transformer select LocatiOn Select Test Organization 

9.P.~~-<.i!J:lr . -· ----- -- --- --·-· 

Select Test Equipment 

_j cancel 

Figure 2.29 Apparatus Selection Dialog Box 
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2. Select the transformer to be tested, the Location, the Test Organization, and the Test 
Equipment. 

3. Click OK. 

Select Test 
4. Click Select Test in the Apparatus and Test pane. 

: 
H2 
H3 
Xl 
X2 
X3 
Yl 
Y2 
Y3 
Hl 
H2 
H3 
Hl 

The Test Selection dialog box appears (Figure 2.30). 

as ·m ... 
H2 as found· m ... none 
X3 extreme rai .. as found· m .. none 
Xl extreme rai ... as found· m ... none 
X2 extreme rai. .. as found· m ... none 
YO extreme rai ... as found· m ... none 
YO extreme rai. .. as found· m ... none 
YO extreme rai... as found· m ... none 
H3 extreme rai ... as found· m ... Xl·X2·X3·X1 
Hl extreme rai ... as found· m ... Xl·X2·X3·X1 
H2 extreme rai. .. as found· m ... X1-X2·X3.X1 
H3 extreme rai. .. as found· m ... Yl.Y2.Y3·Y1 

' ·~ ' ·~· ·~' ·~ 

none 
none 
none 
none 
none 
none 
none 
none 
none 
none 

Figure 2.30 Test Selection Dialog Box 

5. Select the desired test. 

6. Click OK. 

ir 
OpenCircuit 
OpenCircuit 
OpenCircuit 
OpenCircuit 
OpenCircuit 
ShortCircuit 
ShortCircuit 
ShortCircuit 
ShortCircuit 

OK Cancel 

7. In the Apparatus and Test pane, select the purpose and oil level conditions from the 
dropdown menus. 

Start Test 
8. Click Start Test, press F2, or select Test !nit > Start Test. 

The Test Details dialog box appears (Figure 2.31 ). 

9. Enter the location of the red and black test leads. 

Trace Name is a combination of the red and black lead locations. If no test template 
has been selected, the fields are blank. 
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F;t:d L~ild Lo~;,lion Bled; L~~d Lociltion 

I"' I I"' I 
LTC Porum OETC (NL TC) Posilion 

jextreme raise I jas found· make note J 

T euninM Shorted Terminals Grounded 
jnone I Jnone I 
Measurement Twe 

I OpenCircuil 3 r Advanced Setup 

TreceName 

• IH3H2 

Note. 

Figure 2.31 Test Details Dialog Box 

10. If you wish to run a nonstandard test, check the Advanced Setup box. 

A message appears, notifying you that you are about to run a nonstandard test 
(Figure 2.32) and that you may not be able to compare the results of this test with 
results from standard tests. 

Advanced Setup invokes a Non-Standard Test. 
Comparison of Non-Standard Test results with Standard Test results may not be possible using the 
supplied SFRA Analysis tools. 
Uncheck Advanced Setup to run a Standard Test 

OK 

Figure 2.32 Nonstandard Test Warning 

11. Click OK. 

The Test Details dialog box expands to display an Advanced Test Protocol section on 
the right (Figure 2.33). 
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Advanced Test Protocol 
F:"'-.: IJ:'Jfi L,:,c_.:J _,, 

IH3 (' El<P<Inded Ronge I 51611: Stop: Step 

LTCPosiUoo DETC (NLTCj Position 

Je~~eme reise jos found· make note j St.;~r\ Fr<?qu<:.>ncy 

T emU~s Sholted Terminals Grounded 
,,, :±l : 

jnone c:lnon::::•:.._ __ _j r ~:;:,!-,·· 
' 

Measurement Type 

] OpenCilcuit ::::;:] r.i Advanced Setup 

TroceName 
H3H2 

Notes 

Run Test ! Cancel 

Figure 2.33 Test Details Dialog Box with Advanced Test Protocol 

12. At the top of the Advanced Test Protocol section, click the option button for Expanded 
Range or Start : Stop: Step and make the desired selections. 

13. Click Run Test. 

Test in Progress 
M5000 instruments perform a number of self-tests, to ensure that: 

• Internal temperature does not exceed acceptable limits (error 950). 

• Noise levels on the test leads do not exceed safe levels for the instrument (error 951 ). 

• Resistance between ground connections is not too high (error 952). 

• The internal MSOOO performance check was successful (error 953). 

If each test is successful, the test begins. If a test fails, an error message appears. 

• Error 950. M5000 instruments are designed to operate in a 50° C I 122° F 
environment for extended periods. The instrument checks internal temperature before 
each test, because an elevated temperature may reduce component life and reduce the 
instrument's reliability. If the temperature is abnormally high, a warning appears. It is 
possible to continue with the test, but the instrument should be switched off for a 
number of minutes to allow it to cool down first. 

• Error 951. Excessive noise on the input channels may cause excessive noise in the 
results. If the input noise level rises too high, it may damage the instrument. 
Consequently, the instrument tests the noise level on the input channels before each 
test. If the test indicates a high noise level, stop the test, ground the bushing terminals 
to reduce static, and restart the test. It is possible to continue with the test, but results 
may be noisy. 
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• Error 952. An SFRA test relies on good test connections at the bushing terminal and 
at the base of the bushing. The instrument tests the ground-loop resistance before 
running a test. A value of less than I ohm is ideal, but less than 5 ohms is usually 
acceptable. Causes of high ground-loop resistance include poor connections to 
bushing studs because of dirt, grease, or paint, or, occasionally, the stud itself not 
being grounded. Consider any measurement above 250 ohms an open circuit. 

• Error 953. The instrument generates signals at a number of frequencies and measures 
them without sending them through the test object. This signal verification test 
confirms that the device is performing as expected. If the test fails, it is still possible to 
continue with the measurement, but check the results for acceptability. 

Checking and Troubleshooting Results 
SFRA is an easy test to perform, but simple problems can occur during a test. These have 
characteristic signatures, described below. 

Monitoring Waveforms 
The instrument allows you to monitor the reference and measured waveforms as you run 
through a test. Click the Waveform tab to display waveforms (Figure 2.18). Both waveforms 
should appear. At very low dB response, the measured waveform may be small. 

Diagnosing Open-Circuit Response 
An open-circuit response may be caused by the black test lead dropping off the bushing, a poor 
connection, or damage within the test lead. The discrete change in the lower frequency range 
in Figure 2.34 shows typical open-circuit behavior: about -90 to -100 dB. Investigate a test 
like this to see if the open circuit lies in the test setup or the transformer. 

·-
·10.: 

-~-

-~-

..,_ 

• 
. ·f ..,_ 

> 
.,_ 

·70-: 

"" 
-so-: 

·100..: 

,oo 
'"' ""' F1equency.H• --------------'==-----------------' 

Figure 2.34 Typical Open-Circuit Response 
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Managing Data 

Default Data Locations 
The Sweep Frequency Response Analyzer Settings dialog box (Figure 2.35) allows you to 
change the folder for data from tests (Data Path) and the various Editors (Editors List Path) 
and the file you wish to use to store template data (Template File). 

~~~=---.. ~~ .. --"""'~-"'""""'~ ·- - -~ 

Sweep Frequency Response Ana.l)';ler Setttngs~ . . . . 
Data Path 
lc:\Dob!e\SFAA\Oata I..:J 
Editors list Path 

IC:\Doble\SFRA\Settir19s 10 
Template F~e 

IC:\Dob!e\SFRA \Settings\ T emplatelislxml I..:J 

[;; Do Not Show SFAA Language Selection Dialog at Startup 

OK I Cancel I 

,_ 

Figure 2.35 Sweep Frequency Response Analyzer Settings Dialog Box 

To change the location of a data folder or template file: 

1. Select Edit > Options 

The Sweep Frequency Response Analyzer Settings dialog box (Figure 2.35) appears. 

2. Click the ellipsis button at the right of the path you wish to change. 

• For Data Path or Editors List Path, the Browse For Folder dialog box appears 
(Figure 2.36). 
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Select Folder To Save Data 

C Desktop 

ttl 1[;) My Documents 

El Q My Computer 
B ..;;,p. HP _PAVILION (C:) 

Oav 
iC:) BACKUP 

!±I li:::) cmdcons 

b Config.Msi 

EJ 0 Doble 

tt: Qdta 

Make New Folder ! OK Jl Cancel 

Figure 2.36 Browse for Folder Dialog Box 

a. Navigate to the desired folder. 

b. Click OK. 

• For Template File, the Open dialog box appears (Figure 2.37). 

look in: j b Settings 

\ 
L..::) 

My Recent 
Documents 

Desktop 

:.) 
My Documents 

-~ 
My Computer 

:~ Equipmentlist.xml 
1:: Locationlist.xml 
:£:{; Organizationtist. xml 

i.':: TemplateUst.xml 

:.:=:: TransformerUst.xml 

liii1 ··--··---·-· --·;=======,-~,::::~=; 
My Neh<Jolk F~e name: I ..:::J Opeo 

Po"" 
jxml files j".xml) ::i] Files ol type: 

Figure 2.37 Open Dialog Box 

a. Navigate to the desired folder. 

b. Select the desired file. 

c. Click Open. 

3. Click OK. 
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Select Data Source 
To select a folder for viewing data: 

1. To search for files in all subfolders of the data folder, check the Search All 
Sub-Folders box on the Data Manager tab. 

Test results are date- and timestamped and saved to the default folder automatically. 
You can set up additional data folders based on transformers, substations, 
manufacturers, or any other category. 

2. To make the folder you select the default folder, check the Set Data Source As Default 
box. 

3. Click Select Data Source. 

The Browse For Folder dialog box appears (Figure 2.36). 

4. Navigate to the desired folder. 

5. Click OK. 

The files appear in the Data Grid. 

6. Click the plus sign to the left of a category in the Data Tree to display the options for 
viewing a subset of data in that category. 

Click Refresh Data Tree if you select a new data source or add SFRA traces to the 
default folder while the software is open. 

To rearrange the order of the columns in the Data Grid, click on a column head and 
drag it to the desired location. 

7. Select one or more traces to view by highlighting the rows in which they appear (see 
"Highlighting Rows in the Data Manager Tab" on p. 2-30). 

8. Click Display Traces. 

9. View the traces on the Magnitude, Phase, or Impedance tabs. 

Export Selected Results to CSV Files 
You can save test files in .csv format, for use in spreadsheets or the M51 00 software viewer. 

To save test files in .csv format: 

1. Select the file(s) in the Data Manager tab (see "Highlighting Rows in the Data 
Manager Tab" on p. 2-30). 

2. Click Export Selected Results To CSV Files. 

The Files Converted dialog box appears (Figure 2.38). 

3. Click OK. 
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Files Converted ·.~ C:\Doble\SFRA\Data\LCRA_FPP AT2 H-X_FPE_70016-1_3-15-2006_1.sfra 
C: \Doble\SFRA\Data\L CRA_FPP AT2 H-X_FPE_70016-1_3-15-2006 _2, sfr a 
C:\Doble\SFRA\Data\LCRA_FPP AT2 H-X_FPE_70016-1_3-15-2006_3.sfra 

OK 

Figure 2.38 Files Converted Dialog Box 

Import Location and Transformer from Results Files 
You can add the Location and Transformer entries from a file to your own settings files 
(LocationList.xml and TransformerList.xml in the Settings folder). 

To import Locations and Transformers from data files: 

1. In the Data Manager tab, select the file(s) from which you wish to import Location(s) 
and Transformer(s) (see "Highlighting Rows in the Data Manager Tab" on p. 2-30). 

2. Click Import Location and Transformer From Results File. 

If a Location or Transformer is imported, a Location Data Copied or Transformer 
Data Copied dialog box appears, with the name(s) of the imported Location or 
Transformer. 

If a Location or Transformer is not imported-typically because it is already in your 
settings files or is in the wrong format-a No Transformers Imported or No Locations 
Imported dialog box appears. 

3. Click OK for each dialog box. 

Highlighting Rows in the Data Manager Tab 
When selecting (highlighting) a row or rows in the Data Manager tab, the standard Windows 
conventions apply: 

• To select a single row, click the gray section at the left of the row. 

• To select several non-contiguous rows: 

1. Hold down the Control key. 

2. Click the gray section at the left of the desired rows. 

• To select a sequence of rows (from top down or bottom up): 

1. Click the gray section at the left of the first desired row. 

2. Hold down the Shift key. 

3. Click the gray section at the left of the last desired row. 

You can also select a sequence and then eliminate individual rows from the sequence by 
pressing Control and clicking the gray section at the left of each row you wish to eliminate. 
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Saving and Deleting Traces 
All completed traces are automatically saved. If the test is canceled, the data is not saved. 

The SFRA software has no Delete option. To delete files, locate the file using the timestamp in 
the folder where it is stored and delete it in Windows Explorer. The filename appears as the 
last column of each row in the Data Manager tab. 

Automatic save and the procedure for deleting files are set up to help protect data from 
inadvertent replacement or loss. 

Importing l.x and 2.x M5100 SFRA Files 
You can import data from M51 00 versions l.x and 2.x software by placing those files in the 
appropriate data source location. When opened, they will be parsed for content, converted to 
the new Doble SFRA format, and renamed with a different extension, so as not to be 
reconverted subsequently. Be sure to back up copies of these files as a precaution against data 
loss. 

Nameplate data in M51 00 versions l.x and 2.x format is not easily converted to 
M5200/M5300/M5400 format. A number of fields are the same, such as Transformer Serial 
Number and Location, but the location oftest leads may be less obvious. Check imported data 
for accuracy and details, with no odd characters in any field, such as @, *,? etc. 

Transferring Data between Machines or PCs 
To transfer data between machines or PCs, copy the desired files to a network or suitable 
medium and use Windows Explorer to navigate to them in the target machine. 

The software will try to identify duplicate files but is not foolproof. Make sure to retain a 
backup when copying and importing data. 

Settings Files 
Settings files contain entered data for: 

• Transformers 

• Locations 

• Test Organizations 

• Test Equipment 

• Test Templates 

The files are in .xml format. To locate them on your computer, select Edit > Options. The 
Sweep Frequency Response Analyzer dialog box (Figure 2.35) displays the file paths. 

To open a settings file, use a standard text editor such as Notepad. Do not use Microsoft Word 
or other word processors, because they will attempt to save files in their native formats, which 
are typically not compatible with SFRA software. This document assumes the use ofNotepad. 

Figure 2.39 displays a simplified view of a Transformer settings file that will be used to 
describe the file in detail. 
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Line# XML Code 

1 <?xml version="l.O" encoding="utf-8"?> 

2 <transformerNameplates> 

3 <transformerNameplate version="l"> 

4 <manufacturer>ABB</manufacturer> 

5 <serialNumber>1234</serialNumber> 

54 </transformerNameplate> 

55 <transformerNameplate version="l"> 

56 <manufacturer>GE</manufacturer> 

57 <serialNumber>~</serialNumber> 

106 </transformerNameplate> 

107 </transformerNameplates> 

Figure 2.39 Simplijied XML Transformer Settings File 

Line numbers apply only to this example--they will vary for other settings files. What is 
important is the xml start and end tags for each section. 

• Line I is always the xml declaration that describes the xml version and encoding used. 
This must not be modified. 

• Line 2 contains a start tag that is the beginning of the container of all transformers in 
the file. It must have a matching end tag (line I 07). 

• Line 3 contains the start tag of the first transformer nameplate and must also have an 
end tag (line 54). 

• Line 55 shows the start of another transformer, which ends on line 106. 

If another transformer were added, it would appear after line I 06 and before 
</transformerNameplates> on line 107. 

72A-2570·01 Rev. H 6/09 ~ ~ ~ ~ 



NOTE 

OJ 

Settings Files 

Merging Settings Files 

We will illustrate the merge procedure using an example. The method for merging transformer 
settings files described here applies to all other settings files. 

Use caution when merging, because an incorrect merge could corrupt your files and 
cause unpredictable results. Be especially careful to avoid duplicate entries in any 
settings file. 

The manual merge described here is prone to cut-and-paste errors. Back up all data and 
settings files before performing a merge operation. 

In this example, we look at two SFRA users who wish to share XML files. 

Figure 2.40 shows a simplified transformer settings file from User A (as viewed in Notepad): 

<?xml version="1.0 11 encoding="utf-8"?> 

<transformerNamep1ates> 

<transformerNamep.late version=''l ''> 
<manufacturer>ABB</manufacturer> 

<serialNumber>l234</serialNumber> 

</transformerNamep1ate> 

<transformerNamepl.ate versi.on="l"> 

<manufacturer>GE</manufacturer> 

<serialNumber>678</serialNumber> 

</transformerNameplate> 

</transformerNamep1ates> 

Figure 2.40 Transformer Settings File- User A 

Figure 2.41 shows another simplified transformer settings file, this one from User B: 

<?xml version="l.0 11 encoding= 11 utf-8"?> 
<transformerNameplates> 

<transformerNameplate version="l"> 

<manufacturer>ACME</manufacturer> 

<serialNumber>9999</serialNurnber> 

</transformerNamep1ate> 

</transformerNameplates> 

Figure 2.41 Transformer Settings File- User B 

User A's file contains two transformers (underlined in the tables for clarity): 
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• ABB, with serial number 1234 

• GE, with serial number 678 

User B's file contains one transformer: ACME, with serial number 9999. 

The safest method for merging is to combine the two files into a new file containing elements 
from both source files. The following procedure merges the contents into a new transformer 
settings file. It makes use of the fact that several versions of Notepad can be run 
simultaneously. 

To merge settings files: 

1. Back up all TransformerList.xml files. 

2. Start an instance of Notepad and open User A's TransformerList.xml file. 

3. Start another instance ofNotepad and open User B's TransformerList.xml file. 

4. Start a third instance of Notepad. 

5. Select the entire text in User A's file and paste it into the blank Notepad. 

6. Close User A's file. 

7. Select just the transformerNameplate section from User B's file (Figure 2.42). 

<transformerNamep1ate version="l"> 

<manufacturer>ACME</manufacturer> 

<serialNumber>9999</serialNumber> 

</transformerNameplate> 

Figure 2.42 Transformer Nameplate Section of User B 's Settings File 

8. Close User B 's file. 

9. In the remaining Notepad, place the cursor at the beginning of line 3 and paste the 
text. 

10. Check that the file has the right format, with carriage returos and indents, to ensure 
readability of the document. 

11. Save the file as TransformerList.xml. 

12. Replace the existing TransformerList.xml file, either by saving the new file to in the 
default location or by dragging and dropping or copying using Windows Explorer. 

Reports 
To display the report (print) format for the plot shown on the Magnitude tab, press 
Ctrl + Shift + P or select File > Print Preview. 

Click the up or down arrow at the upper right corner of the Preview window (to the right of the 
Page field) to view each page. 

Reports consists of two parts: 

• The graph area, showing the traces on the graph that are checked in the Legend pane. 
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• The test details for each trace. 
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3. Testing 

Preparation 

Transformer 
The transformer to be tested must be completely isolated from the power system. This requires 
that all bushings of all windings be disconnected from any bus and insulators. This ensures 
that measurements are not adversely affected by interference. 

We wish to measure only the RLC network of the transformer. To maintain consistency and 
repeatability of measurements, all terminals not under test should be isolated and floating. To 
maintain a balanced and symmetrical approach, where a delta winding is completed and 
grounded external to the transformer tank, the delta should be complete but floating. Such 
windings are frequently used for regulation; where such windings are grounded internal to the 
tank, we are forced to leave that ground in place-but we should expect asymmetry in the 
results. 

We could measure a frequency response with the remaining terminals grounded, but it could 
not be compared to a response measured with floating terminals, which would display a 
different RLC response. 

SFRA Instrument 

M5300 
Turn on the power switch located on the front of the M5300. 

The M5300 SFRA software should start automatically. If your system has been modified, 
double-click the SFRA icon or select Start> All Programs> Doble Engineering> SFRA. 

The M5300 has a connector for an external video monitor, if desired. The monitors can be 
configured to run simultaneously or separately in the Windows Control Panel > Display. 

M5200 or M5400 and PC 
1. Power on the M5200 or M5400 without connecting it to the PC. 

The power light should come on. Both LEOs come on, then go out, and fmally the 
System OK LED comes on. 

Make sure the SFRA software is installed on your PC's hard drive, not a network 
drive. 

2. Turn off wireless connections and disable firewalls and antivirus software. 

These restrictions do not apply if you wish to use the software in Viewer mode only, 
without communicating with an M5200 or M5400. 

3. Double-click the SFRA desktop icon or select Start > Programs > Doble Engineering 
> SFRA to start the software. 
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4. When the Connect To Instrument dialog box appears (Figure 3.1 ), connect the M5200 
or M5400 to the PC, using either the USB or Ethernet cable. 

Earlier models were supplied with an Ethernet cable and a separate crossover adapter, 
which must be used for the instrument to function. Later models have the crossover 
built into the Ethernet cable. 

i. ?. J. 

~ 

Turn on Instrument for at least 20 seconds. 
Attach communication cable. 
Wait for system ready light to turn on1 test light off. 

Press 'Yes' to start Instrument connection. 
Press 'No' to use viewer only, 

Yes No 

Figure 3.I Connect to Instrument Dialog Box 

5. Click Yes to connect to the M5200 or M5400 only if: 

• The M5200 or M5400 has been powered on. 

• The System 0 K LED is on and the Test In Progress LED is off. 

• The instrument is connected to the PC with a USB or crossover Ethernet cable. 

The Select Instrument dialog box appears. The upper pane displays instruments 
located on the network or is blank if none were found (Figure 3.2). 

~~--~~~=--~-~ 

S~lec~t ll]str~mJ;2! ~~ _ -~"-·-----"---~-~ -~ :._ ___ _ 

No instruments found. Choose Viewer, Continue discovery or Quit 

Warning: If you choose to Continue, the Networ~ wlll be Reset ! 

----'C=occntlnu=,e Searching for Instruments 

Viewer Mode Exit SFRA 

Figure 3.2 Select Instrument Dialog Box 

If the PC is unable to locate the instrument: 

a. Check your connection to the instrument and your IP address (if using 
Ethernet). 

b. Click Continue Searching For Instruments. 
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Test Leads 

You also have the option to use Viewer mode or exit SFRA. 

6. When instruments appear, select the desired instrument. 

7. Click Select Instrument. 

If the PC can communicate with the instrument but cannot transfer data, the 
Connection Error dialog box appears (Figure 3.3). This can occur with a faulty cable 
connection or if a firewall or antivirus software is preventing communication. 

No login possible. 
Check Connectlons:1 then restart test, 

If stlll no login1 

check and correct Instrument IP address in SFRA_M5200.exe.config 
Restart Application if Address is Changed 

OK 

Figure 3.3 Connection Error Dialog Box 

If the PC is unable to communicate with the M5200 or M5400, the Connection Not 
Attempted dialog box appears (Figure 3.4). 

,__~ Connection not Attempted. Running in viewer mode. 

OK 

Figure 3.4 Connection Not Attempted Dialog Box 

Test Leads 

Checking Test Leads 
1. Connect the test leads to the instrument; these are color-coded cables with BNC 

adapters. 

Test leads may be damaged through incorrect storage, mishandling in application, or 
accidental damage on site. It is important to check the status of the leads before 
performing a measurement. This can be done by a short-circuit leads test, as described in 
the next step. 

2. Short the measurement clips (cable end) on the cables together, red to black, and the 
ground clips (middle of cable) together, red-green to black-green. Do not connect the 
measurement clips to the ground clips. 
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To minimize the chance of the conductors becoming energized due to static electricity, 
Doble recommends attaching all leads to the instrument while the other ends of the leads 
are still on the ground. Attaching the leads to the transformer bushings first increases 
the risk of operator injury. 

3. Perfonn a short-circuit measurement (see "Short Circuit" on p. 3-6). 

The short-circuit lead response test verifies proper condition of the test specimen 
cable. Since there is no attenuation, signal loss between the Source/Reference and 
Measure, the resulting data graph plots along the 0 dB horizontal line as frequency 
increases, until an inductive rolloff occurs (Figure 3.5). 

This rolloffis a feature of the cables, because of the 12ft /3.7 m ground connections. 
This roll off is consistent for all tests and reduces the variability in response arising 
from variations in ground lead length. It is expected and acceptable. 

4. Compare your result to the curve in Figure 3.5. 

,_ 

<-

Figure 3.5 Short-Circuit Lead Response 

5. If your result resembles Figure 3.6 rather than Figure 3.5, troubleshoot the leads for an 
open circuit. 

Open-circuit behavior is around -90 to -100 dB but is clearly affected by noise and 
shows a lot of"hashing" compared to the short-circuit lead response. It is relatively 
easy to identify. 

6. Connect the safety ground to the instrument and to the ground on the transfonner. 
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Figure 3.6 Open-Circuit Lead Response 

Cable Length 

Performing a Test 

" 

The SFRA instrument uses RG-58 50-ohm impedance-matched test leads. The SFRA 
measurement requires a matched-impedance signal cable and performs a single-ended 
measurement-the signal with respect to the instrument ground. Thus, the shield of the signal 
cable must be connected to the chassis using RF BCN connectors. 

Practical field experience dictates that leads be 60 ft I 18 m long. This has been selected as the 
minimum length required to test the largest transformers from a location on the ground 
adjacent to the unit. Nevertheless, lead length determines the maximum effective frequency. 
At 60 ft I 18 m, the cable approximates the wavelengths of the higher measurement 
frequencies, and probably little is gained from the 2-10 MHz scan. As long as the cable length 
is less than one-quarter of a wavelength, the short-cable approximation can be used. At lengths 
greater than one-quarter of a wavelength, phasing effects start to occur. It turns out that at 60 ft 
I 18 m, the frequency cutoff with respect to wavelength is approximately 2 MHz. 

It is important to not only recognize any problems with cables but to be prepared to confirm a 
problem further-for example, by having an ohmmeter available if the instrument detects an 
open circuit in a cable. Connections to the apparatus must be contaminant-free metal-to-metal 
junctions. This assures not only reliable and efficient SFRA data collection but helps reduce 
the effects of noise and interference inherent in a substation environment. Remember that a 
bad connection to the apparatus can appear as an open-circuit cable. 

Performing a Test 
Connect test leads to the transformer according to the recommended tests in "Test Templates" 
on p. 3-6. 

A test consists of three stages: 

• Initiate the test (F2) . 
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• Monitor the test progress. 

• Test finishes or is aborted (F2). 

It is important to monitor the test in progress, to make sure good data is being collected. 

Response results appear as soon as the instrument begins to receive data. The software 
continues to plot results until the test is complete. 

Powering Off the SFRA Instrument 
• M5200 and M5400. Power off using the power switch. 

• M5300. Shut down the M5300 using standard PC practice: Select Start > Shut Down. 

Connections 
Generally, an SFRA measurement is made from one terminal on the transformer (e.g., HI or 
A) to another terminal (e.g., H2 or N). 

It is important to record all relevant information, which includes tap position, oil level, and 
terminals grounded or shorted. 

Where previous test results exist, the best testing procedure is to repeat those tests, taking note 
of tap position, shorted or grounded bushings, and any details for specific tests. 

Doble is a key member of international bodies such as CJGRE and IEEE, which are pursuing 
FRA test standards. As standards develop, recommended tests may be changed with input 
from experienced users around the world. Doble will reflect those changes. 

Measurement Types 

Open Circuit 
An open-circuit measurement is made from one end of a winding to another, with all other 
terminals floating. For a delta winding, connections would be HI to H3, for example. For a 
star (wye) winding, measurements are taken from HV terminals to neutral, such as XI to XO. 

Short Circuit 
A short-circuit measurement is made with the same SFRA test lead connections as an 
open-circuit measurement, but with the difference that another winding is short- circuited. To 
ensure repeatability, Doble recommends that the three voltage terminals on the shorted 
winding be shorted together. This would mean, for example, shorting XI to X2, X2 to X3, and 
X3 to XI. This ensures that all three phases are similarly shorted, to give a consistent 
impedance. Any neutral connections available for the shorted winding should not be included 
in the shorting process. 

Test Templates 

3-6 

The test templates given here require performing open-circuit and short-circuit tests. 

A standard set of tests, recorded when a baseline is needed and there is no question of the 
transformer's health, consists of a set of results taken only at extreme tap position. Doble 
recommends that the LTC be in the extreme raise position. However, if the transformer is 
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Notes 

being tested for post-event reasons, such as fault, this should be done in the as-found LTC 
position. Note the tap positions on the test report and apply them during the start of each test. 

Doble recommends leaving the DETC in the as-found position. The DETC position should not 
be moved for an SFRA test until all options are exhausted. For new transformers in the 
factory, use the nominal DETC position, unless otherwise specified by the end-user. 

Notes 
• Leads. Each table gives the recommended tests with position of the red lead and black 

lead clearly identified. Reversing these test leads may provide small variations in 
higher-frequency response. Therefore, take care to attaching test leads appropriately. 

• Grounding. Good grounds are key to good high frequency responses. Make sure 
grounds are not hampered by loose connections, paint, dirt, or grease. 

• LTC position. Changing LTC will change SFRA response; LTC position should be 
recorded. At neutral tap, the previous tap position should also be recorded. 

• DETC position. Transformers in service occasionally have problems due to DETC 
movement. Doble does not recommend altering the DETC position for an SFRA test. 
The exception is in factory tests on a new transformer, where it can be assumed that 
the DETC is in operating condition and tests can be performed on nominal tap. 

Two-Winding Transformers 

Table 3.1 Two-Winding Transformers- 9 Tests 

3$ 3$ 3$ 3$ 
Delta- Wye- Delta- Wye-

Test Type Test# Wye Delta Delta Wye 1$ 

HV Open Circuit ( OC) Test I Hl-H3 Hl-HO Hl-H3 Hl-HO Hl-H2(HO) 
All Other Terminals Floating 

Test2 H2-Hl H2-HO H2-Hl H2-HO 

Test 3 H3-H2 H3-HO H3-H2 H3-HO 

LV Open Circuit ( OC) Test4 Xl-XO Xl-X2 Xl-X3 Xl-XO Xl-X2 
All Other Terminals Floating 

Test 5 X2-XO X2-X3 X2-Xl X2-XO 
(XO) 

Test6 X3-XO X3-Xl X3-X2 X3-XO 

Short Circuit (SC) Test 7 HI-H3 Hl-HO Hl-H3 Hl-HO Hl-H2(HO) 
High (H) to Low (L) Short 
Short [Xl-X2-X3]* Test 8 H2-Hl H2-HO H2-Hl H2-HO Xl-X2(XO) 

Test 9 H3-H2 H3-HO H3-H2 H3-HO * 

* Indicates short-circuit tests where the terminals are shorted together with three sets of Jumpers, to 
provide syounetry (Xl-X2, X2-X3, X3-Xl) OR (Yl-Y2, Y2-Y3, Y3-Yl). The neutral is not 
included for 3$ wye connections but may be included for I$ test connections. 
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Autotransformers 

Table 3.2 Autotransformer without Tertiary or with Buried Tertiary- 9 Tests 

Test Type Test# 3<J> l<J> 

Series Winding (OC) Test I HI-XI HI-XI 
All Other Terminals Floating 

Test 2 H2-X2 

Test 3 H3-X3 

Common Winding (OC) Test 4 XI-HOXO XI-HOXO 
All Other Terminals Floating 

Test 5 X2-HOXO 

Test 6 X3-HOXO 

Short Circuit (SC) Test 7 HI-HOXO HI-HOXO 
High (H) to Low (L) Short 
Short [XI-X2-X3]* Test 8 H2-HOXO [XI-HOXO]* 

Test 9 H3-HOXO 

* Indicates short-circuit tests where the terminals are shorted together with three sets of jumpers, to 
provide symmetry (XI-X2, X2-X3, X3-XI) OR (YI-Y2, Y2-Y3, Y3-YI). The neutral is not 
included for 3<1> wye connections but may be included for I<!> test connections. 

Three-Winding Transformers 

Table 3.3 Three-Winding Transformer Table, Part 1-18 Tests 

3<1> 3<1> 3<1> 3<J> 
Delta- Delta- Delta- Delta-
Delta- Delta- Wye- Wye-

Test Type Test# Delta Wye Delta Wye l<J> 

IN Open Circuit (OC) Test I HI-H3 HI-H3 HI-H3 HI-H3 HI-H2 
All Other Terminals Floating 

Test 2 H2-HI H2-HI H2-HI H2-HI 
(HI-HO) 

Test 3 H3-H2 H3-H2 H3-H2 H3-H2 

LV Open Circuit (OC) Test 4 XI-X3 XI-X3 XI-XO XI-XO XI-X2 
All Other Terminals Floating 

Test 5 X2-XI X2-XI X2-XO X2-XO 
(XI-XO) 

Test 6 X3-X2 X3-X2 X3-XO X3-XO 
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Three-Winding Transformers 

Table 3.3 Three-Winding Transformer Table, Part 1 -18 Tests 

Tert Open Circuit (OC) Test 7 Y1-Y3 Yl-YO Yl-Y3 Yl-YO Yl-Y2 
All Other Terminals Floating 

Test 8 Y2-Y1 Y2-YO Y2-Yl Y2-YO 
(Yl-YO) 

Test 9 Y3-Y2 Y3-YO Y3-Y2 Y3-YO 

Short Circuit (SC) Test 10 H1-H3 Hl-H3 H1-H3 Hl-H3 Hl-HO 
High (H) to Low (L) Short 
Short [Xl-X2-X3]* Test 11 H2-Hl H2-Hl H2-Hl H2-H1 [X1-X2]* 

Test 12 H3-H2 H3-H2 H3-H2 H3-H2 

Short Circuit (SC) Test 13 Hl-H3 H1-H3 H1-H3 Hl-H3 Hl-HO 
High (H) to Tertiary (T) Short 
Short (Yl-Y2-Y3]* Test 14 H2-H1 H2-Hl H2-H1 H2-Hl [Y1-Y2]* 

Test 15 H3-H2 H3-H2 H3-H2 H3-H2 

Short Circuit (SC) Test 16 X1-X3 Xl-X3 Xl-XO Xl-XO X1-XO 
Low (L) to Tertiary (T) Short 
Short [Yl-Y2-Y3]* Test 17 X2-Xl X2-X1 X2-XO X2-XO (Y1-Y2]* 

Test 18 X3-X2 X3-X2 X3-XO X3-XO 

*Indicates short-circuit tests where the terminals are shorted together with three sets of Jumpers, to 
provide symmetry (Xl-X2, X2-X3, X3-X1) OR (Y1-Y2, Y2-Y3, Y3-Yl). The neutral is not 
included for 3<jl wye connections but may be included for 1<jl test connections . 
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Table 3.4 Three-Winding Transformer Table, Part 2-18 Tests 

3$ 3$ 3$ 3$ 
Wye- Wye- Wye- Wye-
Wye- Wye- Delta- Delta-

Test Type Test# Wye Delta Wye Delta 

HV Open Circuit ( OC) Test 1 Hl-HO Hl-HO HI-HO Hl-HO 
All Other Terminals Floating 

Test 2 H2-HO H2-HO H2-HO H2-HO 

Test 3 H3-HO H3-HO H3-HO H3-HO 

LV Open Circuit (OC) Test 4 Xl-XO Xl-XO XI-X2 XI-X2 
All Other Terminals Floating 

Test 5 X2-XO X2-XO X2-X3 X2-X3 

Test 6 X3-XO X3-XO X3-XI X3-XI 

T ert Open Circuit ( OC) Test 7 YI-YO YI-Y2 YI-YO YI-Y2 
All Other Terminals Floating 

Test 8 Y2-YO Y2-Y3 Y2-YO Y2-Y3 

Test 9 Y3-YO Y3-YI Y3-YO Y3-YI 

Short Circuit (SC) Test 10 Hl-HO Hl-HO Hl-HO Hl-HO 
High (H) to Low (L) 

Test II H2-HO H2-HO H2-HO H2-HO Short [XI-X2-X3]* 

Test 12 H3-HO H3-HO H3-HO H3-HO 

Short Circuit (SC) Test 13 HI-HO HI-HO Hl-HO Hl-HO 
High (H) to Tertiary (T) 

Test 14 H2-HO H2-HO H2-HO H2-HO Short [YI-Y2-Y3]* 

Test 15 H3-HO H3-HO H3-HO H3-HO 

Short Circuit (SC) Test 16 XI-XO XI-XO XI-X2 XI-X2 
Low (L) to Tertiary (T) 

Test 17 X2-XO X2-XO X2-X3 X2-X3 Short [YI-Y2-Y3]* 

Test 18 X3-XO X3-XO X3-XI X3-XI 

* Indicates short -circuit tests where the terminals are shorted together with three sets of jumpers, to 
provide symmetry (XI-X2, X2-X3, X3-XI) OR (YI-Y2, Y2-Y3, Y3-Yl). The neutral is not 
included for wye connections. 

In this section we give typical results from a number of transformer windings and designs. 
These are examples of how results vary between transformers - both designs and phases. 

Three Responses for One Transformer 
Figure 3.7 shows the two open-circuit responses and the short-circuit response of one phase of 
an autotransformer. The three traces are clearly quite different at low frequencies. 
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HV Delta Response 

Typically, the HV response starts at a much lower level than the LV response. The 
short-circuit response approaches 0 dB at low frequency but comes back in line with the HV 
response at higher frequencies. 
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Figure 3. 7 Responses for One Phase of a Transformer-

Open Circuit HV (Blue), Open Circuit LV (Red), and Short Circuit (Green) 

HV Delta Response 
Figure 3.8 shows the responses for three phases of a HV delta winding. This is a characteristic 
response at low frequencies: 

• The center phase has a slightly higher impedance (more negative response) at lower 
frequencies. 

The center phase is different from the outer phases at the first resonance below I 0 
kHz. 

• The center phase is similar to the outer phases as frequency rises. 

• All three phases have the same basic shape above about I 00 kHz. 
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Figure 3.8 HV Delta Winding Responses 

HV Wye (Star) Response 
Figure 3.9 shows a typical HV wye (star) winding response. All three phases show similar 
responses at low frequencies, with the following characteristics: 

• The center phase has a slightly increased impedance (more negative dB) at low 
frequencies. 

• The center phase has one resonance and the outer phases two resonances below about 
I kHz. 

• The outer phases are similar at low frequencies. 

The three phases "come back together" as frequencies rise toward I 0 kHz. 

• The three phases show regions of similarity and regions of dissimilarity across the 
frequency range. 
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Short-Circuit Test Response 
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Figure 3.9 HV Wye Winding Response 

Short-Circuit Test Response 
Figure 3.10 shows the three short-circuit responses from the HV side of a transformer. Clearly, 
the responses are similar, whlch is what we would expect from thls test. 
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Figure 3.10 Sltort-Circuit Test Response 

Even when we zoom in on the responses (Figure 3.11 ), they are still quite similar. This is a 
useful diagnostic where no previous results are available. 
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Figure 3.11 Short Circuit Response- Detail 

Repeat Results for One Phase at Different Times 
The two responses in Figure 3.12 were taken 18 months apart. The original data was taken as a 
baseline set of results; the subsequent data was taken after an incident involving the 
transformer. The results are similar. 
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Figure 3.12 Repeat Results for One Phase 

Low-frequency variation, below about 5 kHz, is characteristic of core magnetism affecting the 
results. The traces have the same basic shape, but one is offset compared to the other. They 
come back into line as we approach I 0 kHz. 
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Results Showing a Shorted Turn 

The higher-frequency results are almost identical. This is strong evidence that there has been 
no change in this transformer. 

Results Showing a Shorted Turn 
A shorted tum produces an effect similar to shorting the low-side windings for a short- circuit 
measurement. The effect is easy to see at low frequencies and does not require reference 
results. 

The original results show the characteristic low-frequency response of a wye (star) winding. 
The subsequent results, taken a year later after a close-in fault, show the characteristic 
response of a short somewhere on that phase. 
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Figure 3.13 Shorted Turn on One Winding 
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4. Analysis 

M5000 Software 
The Analysis tab (Figure 4.1) allows you to compare the overlapping ranges of two traces. For 
example, if one trace is I 0 Hz to 2 MHz and the other is 20 Hz to I 0 MHz, the analysis covers 
20 Hz to 2 MHz-the higher of the lower values to the lower of the higher values. The upper 
pane displays the two traces you select; the lower pane displays the difference between them. 
You can perform a difference analysis or a correlation analysis. 
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Figure 4.1 Analysis Tab 

To select traces for analysis: 

1. Click Select Traces. 

The Select Traces dialog box appears (Figure 4.2). 

2. Check the boxes for the two traces you wish to analyze. 

3. Click OK. 
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Difference Analysis 

L_j X3·XD_2006·10·22_16·22·09_Smooth 
' ... i Y2·YD_2006·1 0·22_16·29·11_Smooth 
[] Y3·Y0_2006·1 D·22_16·31·43_Smooth 
':i Xl·X0_2006·1 D·22_16·39-44_Smooth 

, X2·X0_2006·1 0·22_16·42·20_Smooth 

OK Cancel 

Figure 4.2 Select Traces Dialog Box 

The difference plot displays the difference between the two traces, using limits you set in the 
DiffLimits In dB section to color the result. In Figure 4.1, for example, the lower limit (yellow 
field) is set at 2.0 dB, and the upper limit (red field) is set at 5.0 dB. Therefore, a difference of 
less than 2.0 dB appears on the difference plot in dark green; a difference between 2.0 dB and 
5.0 dB appears in yellow, and a difference of more than 5.0 dB appears in red. 

After entering the desired limits in the DiffLimits In dB fields, click Calculate to display the 
difference plot with the new settings. 

Correlation Analysis 
You can perform correlation analysis on subsections of the two traces. Cross-correlation 
coefficients appear in the Analysis tab when two results are compared. The results can range 
from -I to 1, where I indicates a perfect comparison, -1 indicates inversion, and 0 indicates 
that the two results are orthogonal. 

1. Set the cursor position for a correlation band by clicking and dragging the cursor or by 
entering the desired value in the corresponding Cursor Position field. 

The cursor for each band corresponds to the background color of that field. The values 
of the correlation coefficients for each range appear in the Correlation Coefficients 
fields. 

2. Set the correlation coefficient limits in the Correlation Limits fields. 

3. If you move a cursor or change the correlation limit values, click Calculate to display 
the new correlation values. 

Analysis Discussion 
Limits have not yet been set on an acceptable variation for difference between two traces on 
the same transformer at a given frequency; likewise, limits have not been set on acceptable 
differences in correlation coefficient in a given frequency range. Both are areas where the 
international SFRA community is currently undertaking research. Doble is involved in the 
latest research and submissions to international standards organizations such as IEEE and 
CIGRE. 

72A-2570·01 Rev. H 6/09 ~~~~ 



Frequency-Dependent Transformer Equivalent Circuit 

Frequency-Dependent Transformer Equivalent Circuit 
The power-transformer equivalent circuit is a complicated network of distributed resistive, 
capacitive, and inductive elements. These include: 

• Capacitance between the neighboring turns of the same winding 

• Capacitance between the turns of different windings 

• Capacitance between the turns and the ground. 

• Turns self-inductance 

• Turns mutual inductance 

• Conductor DC resistance. 

• Resistance that accounts for dielectric losses in insulation 

• Resistance that accounts for eddy losses in conducting and magnetic components 

Depending on the test lead connection, the equivalent circuit involved in the measurement 
represents an individual phase of the winding, the space between phases in a winding, or the 
space between windings. Size of the conductors, diameters of the coils, distance between the 
coils, distance between the windings, number of turns, type of the core, winding configuration, 
type and thickness of insulation, and geometry and size of supporting material are among the 
factors that defme the elements of the equivalent circuit. Furthermore, each element is specific 
to the transformer design and even influenced by the ability of the manufacturing shop to 
replicate units of the same design. Therefore, there is a direct relationship between the 
geometry of core-winding configuration and the network of distributed resistive, capacitive, 
and inductive elements. 

Since reactance of capacitive and inductive elements is frequency-dependent, each element's 
contribution to the overall network impedance varies with frequency, making the equivalent 
circuit unique at each frequency. Therefore, the signature that represents the changing 
continuum of the network impedance with frequency uniquely describes the geometry of the 
core-winding configuration for a given unit and carries a wealth of diagnostic information. 

The network impedance, which is the ratio of the output and input signals, is often referred to 
as the transfer fimction. Sweep frequency response analysis (SFRA) uses the transfer function 
behavior over the specified range of frequencies as the transformer's diagnostic signature. 
Transfer function, as a complex variable, is described by the magnitude and the phase angle. 

Diagnostic Significance of Frequency Ranges 
Diagnostics of frequency ranges are discussed on two levels: per-phase open-circuit 
measurement and short-circuit measurement. 

Per-Phase Open-Circuit Measurement 
As the name implies, per-phase measurement targets the individual phase of a winding. At low 
frequencies, the influence of capacitance is negligible, and the winding behaves as an inductor. 
Therefore, the attenuation (described by the magnitude of the transfer function) and the phase 
shift (described by the phase of the transfer function) of the low-frequency sinusoidal signals, 
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passing through the winding, are determined by the inductive and resistive nature of the 
network. 

The inductive characteristics are determined by the magnetic circuit of the core, and the 
resistive characteristics are dominated by the resistance of the output measuring cable. 

Figure 4.3 and Figure 4.4 are examples of transfer-function magnitude and phase for a 
per-phase measurement. 
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Figure 4.3 Per-Pizase Measurement- Magnitude of tlze Transfer Function 

In Figure 4.4, the phase angle is about 80 degrees, indicating the inductive nature of the total 
impedance (in the region below I kHz). For a three-legged core-type unit, the magnetic flux 
coupled with the outer phase (Hl-H3 or H3-H2 in Figure 4.3) faces a different reluctance than 
the flux coupled with the middle phase (H2-Hl in Figure 4.3). 

Therefore, the corresponding magnitude traces, in the low-frequency range, differ as 
well-i.e., the traces for the two outer phases correlate closely and are shifted from the 
middle-phase trace. The presence of the residual magnetism may have an effect on 
relationship between the traces. This is the same phenomenon that, during exciting current and 
loss measurement, creates a pattern of two high similar and one lower reading under normal 
conditions and a slightly distorted pattern in the presence of residual magnetism. 
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Short-Circuit Measurement 
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Figure 4.4 Per-Phase Measurement- Phase of the Transfer Function 

As the frequency of the input signal increases, the capacitive effects begin to dominate and the 
phase angle quickly becomes close to +90 degrees (in the region above I kHz). Now, the 
attenuation and the phase shift of the high-frequency sinusoidal signals, passing through the 
winding, are determined by inductive and capacitive nature ofthe network. However, in the 
high-frequency region, the inductive characteristics are determined by the leakage flux 
coupling, and the capacitive characteristics are determined by the various capacitance 
elements associated with individual turns. The propagation characteristic of the winding 
becomes complex as a result of the many resonance frequencies found in the high-frequency 
range. However, since the winding responses become less dependent on the magnetic circuit 
of the core, the traces of the three phases converge and become quite similar. 

As the frequency increases even further (over I 00 kHz in Figure 4.4), the sinusoidal signals 
travel mostly outside the winding and reflect the other elements found in the 
transformer-e.g., leads, support insulation, etc. The magnitude and the phase of the transfer 
function in that frequency region are influenced by the inductive-capacitive- resistive nature of 
these elements. 

Although most of the low-frequency magnitude responses exhibit a typical shape, there are no 
typical form responses in the high-frequency region. These vary greatly with the design of the 
unit. Therefore, the frequency ranges noted in the description of Figure 4.3 and Figure 4.4 are 
different for different units. 

Short-Circuit Measurement 
The aim of this measurement is to allow direct comparison between the three phases of a 
three-phase transformer where no prior measurements exist. 

Taking a measurement on one winding with another winding short-circuited removes the 
effect of the core at low frequencies. The resulting response is that for a large inductor with no 
core. The responses for all three phases should be similar at low frequencies. 
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The theory behind the short-circuit measurement is straightforward: 

Any two-winding transformer can be modeled at low frequencies by a simple T model 
(Figure 4.5). 

HVWinding LV Winding 

R Small R Small 

RHigh 

Figure 4.5 T Model of Transformer Winding 

The impedance of the windings is small, while the impedance of the core to ground is 
extremely high. This means that for any input signal, the response is dominated by the core. 
By adding a short to the LV side, the effect of the core is removed, and the response is 
dominated by the windings, which are predominantly inductors at low frequency. The 
response of an inductor is to have a low dB response at low frequency, with an inductive 
roll off as frequency rises (Figure 4.6). 

LV Winding HVWinding 

~DJl~--.-~~~L-----~ 

R Small R Small 

Core R High LV Short 

Figure 4.6 T Model with LV Short 

All three phases of a transformer have similar winding inductances, which means their 
responses should be similar. See the next section for examples of the use of the short-circuit 
response for diagnostic purposes. 
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Analysis of Test Data 

Analysis of Test Data 

Failure 
Type 

Initial Measurement 
Present state of the art is such that analysis of SFRA data is based only on a subjective 
comparison of traces. For the initial measurement, the traces are analyzed for changes between 
responses of the three phases of the same transformer and changes between responses of 
transformers of the same design. Obviously, for a single-phase unit, only the latter comparison 
applies. 

The appearance of new features or major resonance frequency shifts is a cause for concern. 
When tapped windings are involved, it is useful to perform measurements on at least two tap 
positions, to assess whether differences in the trace originate from the tapped or untapped 
sections of the winding. 

When interpreting differences observed between phases, bear in mind that for many windings, 
the disposition of internal connections between windings, bushings and tap-changers may 
necessitate minor design differences that could introduce small differences between phases in 
the frequency response. Therefore, for the initial measurement, if you observe minor 
differences between phases, it is not possible to make an unambiguous conclusion about the 
presence of winding deformation. Fortunately, responses obtained for units of the same design 
can often serve as reference data for each other. 

Short-circuit measurements allow for direct phase-to-phase comparison of a three-phase 
transformer. 

Subsequent Measurement 
For subsequent measurements, analyze traces for changes between the initial and subsequent 
response. Considerations described for the initial measurement apply here also. 

Low-frequency variations usually relate to core effects, including residual magnetism, which 
may provide variation between responses. 

Higher frequencies, above I MHz, may be affected by grounding quality. This is easy enough 
to identify but must be considered as a cause of variation. 

Other Diagnostic Measurements 
Each FRA diagnostic measurement has failure modes to which it is most sensitive as its 
purpose in life. Therefore, understanding the significance of each measurement and knowing 
its associated failure modes is essential for a successful diagnostic investigation. Table 4.1 
relates typical failure modes with various diagnostic measurements. This table also shows that 
no single method can cover the multitude of problems occurring in transfonners. 

Table 4.1 Diagnostic Tests 

Failure Failure Diagnostic 
Mechanism Mode Measurement 
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Chapter 4: Analysis 

Table 4.1 Diagnostic Tests 

Windings Electromagnetic forces caused by overcurrent Winding distortion FRA, leakage 
conditions change the geometry of the winding, reactance 
thus changing the measured leakage reactance. 

Insulation failure creates a circuit coupled with the Tum-to-tum winding failure: FRA, exciting 
main flux. The resulting circulating current creates . One or more turns are current and loss, 
a load component in the measured exciting current short-circuited DGA 
and loss. completely. 

• Two or more parallel 
strands of different turns 
are short- circuited. 

Insulation failure creates a circuit coupled with the Strands within the same tum Leakage loss, DGA 
leakage flux. The resulting circulating current are short-circuited. 
contributes a load component to the measured 
leakage loss. 

LTC Contacts Contact problems affect the current circulating Misaligmnent, mechanical Exciting current and 
through the preventive autotransformer in bridging problems, coking and wear of loss, DGA 
positions. The change in the circulating current LTC and DETC contacts 
influences the load components of the exciting 
current and the loss measured in the bridging 
positions. 

DETC Contact problems change the resistance of the Misaligmnent, mechanical DC winding 
Contacts current path. problems, coking and wear of resistance, DGA 

LTC and DETC contacts 

Conductors Movement of conductors results in the breaking of Open circuit, broken strands, Exciting current and 
strands and the deterioration of terminations termination problems loss, DC winding 
changing the resistance of the current path. resistance, DGA 

Core Movement or over excitation of the magnetic Overheating due to FRA, exciting 
system creates a circuit coupled with the main flux. (abnormal) circulating current and loss 
The resulting circulating current contributes a load currents in the core, clamping 
component to the measured exciting current and components and through 
loss. multiple core grounds 

Miscellaneous Moisture, aging, contaminants, poor maintenance, Dielectric breakdown of Power factor and 
and manufacturing defects leads to insulation insulation capacitance 
deterioration. (including 

measurements on 
bushings), oil tests, 
DGA 
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5. Troubleshooting 

Field Repairs 
There are no user-maintainable parts in the M5000 instruments. For support, contact Doble 
customer service at 617-926-4900 or email customerservice@doble.com. 

In case of a severe problem, your Doble technical support team may recommend removing one 
of the boards in the instrument to return to Doble. This is a simple process, but take 
appropriate precautions to prevent electrostatic buildup and discharge damage to the boards: 

1. Disconnect the instrument from the power supply. 

2. Remove power leads and test cables. 

3. Remove the main cover. 

4. Disconnect the power supply from the input connector on front panel 

5. Unscrew the main circuit board assemblies, complete with power supplies. 

Before returning any defective modules to Doble, call or email Doble customer service to 
receive an RMA number. Return the main modules in padded and protective packaging. 

The shipping address is: 

Customer Service Manager 
Doble Engineering Company 
85 Walnut Street 
Watertown, MA 02472-4037 
USA 

Replacement Parts 
A number in the Qty column of a table indicates the number shipped with each unit. Contact 
Doble Customer Service to order replacement parts. 

M5200 and M5400 
Table 5.4lists cables and adapters used with the M5200 and M5400. If a system failure is 
traced to a cable, ensure that the cable is properly seated and connected before replacing it. 

Table 5.1 M5200 and M5400 Cable and Adapter Sltipping/Replacement List 

Qty Description Part No. 

I Bag, Cable, Large 2FB-3449-0I 
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Chapter 5: Troubleshooting 

Table 5.1 M5200 and M5400 Cable and Adapter Shipping/Replacement List 

I Cable, Ground, 30 ft I 9 m, M4K I M2H I MEV 02C-OO 19-0 I 

I Cable, RJ45 I Cat 5E, Crossover, 7 ft I 2 m 181-0646 

I Cable, Specimen Test, 60ft I 18m OSB-0659-04 

Cable, Specimen Test, I 00 ft I 30 m 05B-0659-05 

I Cable, USB, AlB, 6 ft I 1.8 m 181-0585 

I Clip, Battery, Solid Copper, 400A 212-0444 

I Cord, Power Country-specific 

Table 5.5 lists other components shipped with the M5200 and M5400. 

Table 5.2 M5200 and M5400 Additional Components 

Qty Description Part No. 

I CD, SFRA, Product Information 08A-0151-0I 

I CD, SFRA Software 08A-0152-0I 

Fuse Littlefuse 312 OOIP Fast Blo, 
3AG Glass Cartridge Ul and 
CSA certified or equivalent 
M5400: Littlefuse 0.75 Amp, 
250 V, Slo-Bio, 3AG, Qty 2 

I SFRA Quick-Start Guide 500-0545 

I SFRA User Guide 500-0590 

M5300 
Table 5.3 lists part numbers for field-replaceable components. 
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M5300 

Table 5.3 M5300 Field-Replaceable Components 

Qty Description Part No. 

1 Assembly, PCB ±15V Converter 04S-0852-01 

1 CPU Module Assembly 03D-1633-01 

1 CPU PC Board 401-0292 

1 Fan 380-0055 

1 Front Panel Assembly 03D-1632-0I 

1 High-Density Drive, 20GB IDE 401-0063 

Fuse Littlefuse 312 01.5P Fast Blo, 
3AG Glass Cartridge ill and 
CSA certified or equivalent 

I Power Supply +5V, ±12V Output 384-0216 

1 PPC41Analog Module Assembly 03D-1631-01 

1 USB Keyboard 401-0295 

Table 5.41ists cables and adapters used with the M5300. If a system failure is traced to a cable, 
ensure that the cable is properly seated and connected before replacing it. 

Table 5.4 M5300 Cable and Adapter Shipping/Replacement List 

Qty Description Part No. 

1 Bag, Cable, Large 2FB-3449-0I 

I Cable, Ground, 30 ft I 9 m, M4K I M2H I MEV 02C-OO 19-0 I 

I Cable, Specimen Test, 60ft I 18m OSB-0659-04 

Cable, Specimen Test, I 00 ft I 30 m OSB-0659-05 

1 Clip, Battery, Solid Copper, 400A 212-0444 

I Cord, Power Country-specific 

Table 5.5 lists other components shipped with the M5300. 
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Table 5.5 M5300 Additional Components 

Qty Description Part No. 

I CD, SFRA, Product btfonnation 08A-015J.OI 

I CD, SFRA Software OSA-0152-01 

Fuse Littlefuse 312 01.5P Fast Blo, 
3AG Glass Cartridge UI and 
CSA certified or equivalent 

I SFRA Quick-Start Guide 500-0545 

I SFRA User Guide 500-0590 

I Software, Win XP, OEM Package 401-0196 
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Appendix B. M5200/M5300/M5400 
Technical Specifications 

Excitation Source 

Channels I 

Frequency Range 10Hz to 25 MHz 

Output Voltage 20 V peak-to-peak at 50 ohms 

Output Protection Short-circuit protected 

Source Impedance 50 ohms 

Calibration Interval 2 years 

Measurement Channels 

Channels 2 

Sampling Simultaneous 

Frequency Range 10Hz to 25 MHz 

Max. Sampling rate 100 MS/s 

Input Impedance 50 ohms 

Calibration Interval 2 years 

Data Collection 

Test Method Sweep frequency 

PC Communication USB/Ethemet 

Frequency Range 10Hz to 25 MHz 

Number of Points 1000 (default); up to 1800 (extended range) 

Point Spacing 1.2% logarithmic 

Dynamic Range >90dB 

Repeatability ±I dB to -80 dB 

IF Bandwidth < 10% of active frequency 
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B-2 

Data Display 

Scaling Linear/Log 

Frequency Range 10 Hz to 25 MHz, user-defmed within frequency range 

Ploning Frequency vs. magnitude I phase 

Analysis Difference, Subwband cross-correlation 

Physical Specifications 

Dimensions M5200: IO.OHx 16.0Wx 15.5Din./25Hx41 Wx40Dcm 
M5300: 10.0 H x 16.0 W x 15.5 Din. /25 H X 41 W X 40 D em 
M5400: 18.2 H X 13.4 W x 6.7 D in./46.2 H x 34.0 W X 17.0 D em 

Weight M5200: 14.6 lb /6.6 kg 
M5300: 22.5 lb /10.2 kg 
M5400: 13.1 lb I 6.0 kg 

Power 115-230 V AC, 50/60 Hz 

Current M5200: I Amp 
M5300: I Amp 
M5400: 0.5 Amp 

Temperature Operating: 0° to 50° C I 32° to 122° F 
Storage: -25° to +70° C /-13° to 158° F 

Relative Humidity ()....95% non-condensing 

Test Lead Construction 

Integrated three-lead Standard(,; 362 kV): 60 ft /18 m 
system in single cable set Optional(> 362 kV): 100ft/30m 

PC Requirements 

M5200 and M5400 Minimum configuration: . Ethernet!USB 

• Windows 2000 or XP . 500 MHz processor . 256MB RAM . 20 MB hard-drive free space . DVD-RW 

M5300 Built-in PC configuration: . WindowsXP . Intel Celeron 1.3 GHz . Minimum 512MB RAM . Minimum 40 GB HOD 

The M5200 and M5300 come with a carrying strap for easy transportation. The M5400 case 
has a handle. 

72A-2570-0I Rev. H 6/09 ~, ~' 



Specifications are subject to change without notice. 
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Sweep Frequency Response Analyzer (SFRA) Quick Start Guide 

Important Notice 
This User Guide ("Guide") and the Doble® trademark are the sole property of the Doble 
Engineering Company ("Doble") and, along with the subject matter to which they apply, are 
provided for the exclusive use of Doble Users ("User") as a result of an accepted sales order or 
under an agreement for Doble test equipment and services. 

In no event does Doble assume liability for any technical or editorial errors or omissions. Doble 
shall in no event be liable for direct, indirect, incidental, or consequential damages arising out of 
reliance, inaccurate third party information or the inability of the User to use this Guide properly. 

Copyright laws protect this Guide; all rights are reserved. No part of this Guide shall be 
reproduced, stored in a retrieval system, or transmitted by any means, electronic, mechanical, 
photocopying, recording, or otherwise without written permission from Doble. 

Doble and the Doble logo are registered in the U.S. Patent and Trademark Office and are 
trademarks of the Doble Engineering Company. 

Doble is providing the information contained herein for reference purposes only. Doble makes 
no warranty or representation that the Guide will meet the User's requirements. This Guide is 
intended to provide a basic understanding and general application of the principles set forth 
herein. Comments contained herein relating to safety represent minimum guidelines, and 
should never be compromised; however, it is foreseeable that the minimum safety guidelines 
may be supplemented in order to conform to User's company safety and compliance 
regulations. User is responsible for applying the information contained herein in strict 
accordance with industry as well as User's company compliance and safety regulations. The 
techniques and procedures described herein are based on years of experience with tried and 
proven methods. However, the basic recommendations contained herein cannot embrace all 
conceivable test situations and there may be instances when Doble should be consulted 
directly. Doble is not responsible for the MISUSE OR REliANCE ON THIS PUBliCATION, 
ANY OPINIONS CONTAINED HEREIN, OR AS A RESULT OF MODIFICATION BY ANYONE 
OTHER THAN DOBLE OR AN AUTHORIZED DOBLE REPRESENTATIVE. UNDER NO 
CIRCUMSTANCES WILL DOBLE BE liABLE TO ANY USER FOR ANY DAMAGES, INCLUDING 
WITHOUT liMITATION, PERSONAL INJURY OR PROPERTY DAMAGE CAUSED BY THE 
PRODUCT, ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES, EXPENSES, LOST PROFITS, 
LOST SAVINGS, OR OTHER DAMAGES ARISING OUT OF THE USE OF OR INABiliTY TO 
USE THIS GUIDE. 

Copyright© 2008 Doble Engineering Company 
All Rights Reserved 
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Warranty 

Warranty 

Equipment Limited Warranty 
Doble warrants the products that it delivers to be free from defects in material and workmanship 
for a period of one (1) year from the date shipped from the Doble facility. Equipment delivered 
under a valid and duly executed Doble Service and Equipment Agreement will be replaced as set 
forth in said agreement. 

During the one-year warranty period, Doble will repair or replace, at its option, any defective 
products or components thereof at no additional charge, provided that the product or component 
is returned, shipping prepaid, to Doble. The Purchaser is responsible for insuring any product or 

component so returned and assumes the risk of loss during shipment. All replaced products and 
components become the property of Doble. 

THIS LIMITED WARRANTY DOES NOT EXTEND TO ANY PRODUCTS WHICH HAVE BEEN 
DAMAGED AS A RESULT OF ACCIDENT, MISUSE, ABUSE, OR AS A RESULT OF 
MODIFICATION BY ANYONE OTHER THAN DOBLE OR AN AUTHORIZED DOBLE 
REPRESENTATIVE. 

EXCEPT AS EXPRESSLY SET FORTH ABOVE, NO OTHER WARRANTIES, EXPRESSED OR 
IMPLIED, ARE MADE WITH RESPECT TO THE PRODUCT INCLUDING, BUT NOT LIMITED 
TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 

PURPOSE. DOBLE EXPRESSLY DISCLAIMS All WARRANTIES NOT STATED HEREIN. IN THE 
EVENT THE PRODUCT IS NOT FREE FROM DEFECTS AS WARRANTED ABOVE, THE 
PURCHASER'S SOLE REMEDY SHALL BE REPAIR OR REPLACEMENT AS PROVIDED ABOVE. 
UNDER NO CIRCUMSTANCES WILL DOBLE BE LIABLE TO THE PURCHASER OR ANY USER 
FOR ANY DAMAGES, INCLUDING WITHOUT LIMITATION, PERSONAL INJURY OR 
PROPERTY DAMAGE CAUSED BY THE PRODUCT, ANY INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, EXPENSES, LOST PROFITS, LOST SAVINGS, OR OTHER DAMAGES ARISING OUT 
OF THE USE OF OR INABILITY TO USE THIS PRODUCT. 

Software Limited Warranty 
Doble warrants that: (i) for a period of one hundred twenty (120) days from the date of shipment 
from Doble, the media on which the Software is furnished will be free of defects in materials and 

workmanship under normal use; and (ii) for a period of one year from the date of shipment from 
Doble, the Software will perform in substantial conformance to its published specifications. This 
limited warranty extends only to the original licensee. Licensee's exclusive remedy and Doble's 
entire liability under this limited warranty will be, at Doble's option, to repair or replace the 

Software, or to refund a pro rata portion of the purchase price. Doble makes no warranty or 

representation that its software products will meet Licensee's requirements, that the operation of 
the software products will be uninterrupted or error free, or that all defects in the software 
products will be corrected. 

This warranty does not apply if the software (a) has been altered, except by Doble, (b) has not 

been installed, operated, repaired, or maintained in accordance with instructions supplied by 
Doble, (c) has been subjected to abnormal physical or electrical stress, misuse, negligence, or 
accident, or (d) is used in ultra-hazardous activities. 
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iii 

IN NO EVENT Will DOBlE BE liABlE FOR ANY lOST REVENUE, PROFIT, OR DATA, OR 
FOR SPECIAl, INDIRECT, CONSEQUENTIAl, INCIDENTAl, OR PUNITIVE DAMAGES, 
HOWEVER CAUSED AND REGARDlESS OF THE THEORY OF liABiliTY ARISING OUT OF 
THE USE OF OR INABiliTY TO USE THE SOFTWARE, EVEN IF DOBlE HAS BEEN ADVISED 
OF THE POSSIBiliTY OF SUCH DAMAGES. In no event shall Doble's liability to licensee, 
whether in contract, tort (including negligence), or otherwise, exceed the price paid by licensee. 
The foregoing limitations shall apply even if the above-stated warranty fails of its essential 
purpose. 

Limitation of Remedies 
Doble's entire liability and Purchaser's exclusive remedy shall be: 

1. The replacement of any disks not meeting Doble's "limited warranty" which are returned 
to Doble. 

2. If Doble is unable to deliver replacement disks which are free from defects in materials 
and workmanship, Purchaser may terminate the license by returning, destroying or 
deleting the software product and all copies thereof in any form and affirming 
compliance with this requirement in writing, Doble will refund the purchase price. 

THE FOREGOING WARRANTIES AND REMEDIES ARE EXClUSIVE AND ARE IN liEU OF All 
OTHER WARRANTIES, TERMS, OR CONDITIONS, EXPRESS OR IMPliED, WHETHER 
AllEGED TO ARISE BY lAW, BY REASON OF CUSTOM OR USAGE IN THE TRADE, OR BY 
COURSE OF DEAliNG, INClUDING WARRANTIES, TERMS, OR CONDITIONS OF 
MERCHANTABiliTY, FITNESS FOR A PARTICUlAR PURPOSE, SATISFACTORY QUAliTY, 
CORRESPONDENCE WITH DESCRIPTION, AND NON INFRINGEMENT, All OF WHICH ARE 
EXPRESSlY DISClAIMED. 

For equipment maintenance, contact: 
Customer Service Manager (Extension 2921) 
Doble Engineering Company 
85 Walnut Street 
Watertown, MA 02472-4037 (USA) 
Telephone: 617-926-4900 
Fax: 617-926-0528 
Email: customerservice@doble.com 
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Sweep Frequency Response Analyzer 

(SFRA) Quick Start Guide 

This Quick Start Guide shows how to take good measurements using a Doble M5200, 
M5300, or M5400 Sweep Frequency Response Analyzer. 

Preparing the Transformer 

CAUTION 

Disconnect all bushings and windings from any connecting busses and/or insulators. 
Terminals not under test should be isolated and floating unless otherwise specified. 

The transformer under test must be completely de-energized and isolated from the 
system. Follow your own company rules, policies, and government regulations to 
ensure safety of personnel and property. The transformer and the MSOOO instrument 
must share a common ground or earthing point. 

Connecting the leads 

M5000 Connections 
MSOOO instruments and leads are configured for use as in Figure 3. Ensure that the 
cables are connected to the instrument according to the color-coded BNC connections. 
You can perform a test-lead integrity check if desired (see the SFRA User Guide). 

Three BNC 
Color-Coded Connectors 

L_ ____ ___)@ 

Safety Ground 

Figure 1. M5300 Connections (M5200 and M5400 Similar) 
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CAUTION 

I 

Transformer Connections 
Make good electrical connections at bushing terminals and at the base of bushings; 
clean, file, or wire-brush connection points if necessary. 

When making short-circuit measurements, ensure that all three phases are solidly 
shorted: 1 to 2, 2 to 3, and 3 back to 1. 

When running a test on a transformer winding-for example, H1-HO-attach the red 
lead to the H1 bushing and the black lead to the HO bushing (Figure 2). 

Red Lead Attached Black Lead Attached 
to H1 Bushing to HO Bushing 

\ / 
.----c""'·J1 ,-<il. 

-~' ·.cJ ~J~] 
Safety Ground/ ....._Test lead grounds should 

attach to stud or bolt 
at base of each bushing 

Figure 2. Connecting Leads to the Transformer to Measure H1-HO 

When connecting leads to a transformer, ensure that you attach the lead grounds to a 
stud or bolt at the base of the bushing and that good electrical contact is established 
and maintained. 

Changing tap position or DETC position or removing core ground connections will give 
different SFRA results. Therefore, where previous results are available, take new 
measurements in a manner consistent with previous results. 

Table 1 through Table 4 show test connections for some common transformer designs; 
the red lead is the first of the two named terminals. For further designs, see the Doble 
Test Connections Guide. 
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Transformer Connections 

Two-Winding Transformers 

Table 1. Two-Winding Transformers- 9 Tests 

3</J 3</l 3</l 3</l 
Delta- Wye- Delta- Wye-

Test Type Test# Wye Delta Delta Wye 1</J 

HV Open Circuit (OC) Test 1 H1-H3 H1-HO H1-H3 H1-HO H1-H2(HO) 
All Other Terminals Floating 

Test 2 H2-H1 H2-HO H2-H1 H2-HO 

Test 3 H3-H2 H3-HO H3-H2 H3-HO 

LV Open Circuit (OC) Test 4 X1-XO X1-X2 X1-X3 X1-XO X1-X2 
All Other Terminals Floating 

Test 5 X2-XO X2-X3 X2-X1 X2-XO 
(XO) 

Test 6 X3-XO X3-X1 X3-X2 X3-XO 

Short Circuit (SC) Test 7 H1-H3 H1-HO H1-H3 H1-HO H1-H2(HO) 
High (H) to Low (L) Short 
Short [X1-X2-X3]* Test 8 H2-H1 H2-HO H2-H1 H2-HO X1-X2(XO)* 

Test 9 H3-H2 H3-HO H3-H2 H3-HO 

* lnd1cates short-c~rcu1t tests where the terminals are shorted together w1th three sets of 
jumpers, to provide symmetry (X1-X2, X2-X3, X3-X1) OR (Y1-Y2, Y2-Y3, Y3-Y1). The neutral 
is not included for 3</l wye connections but may be included for 1 <P test connections. 

Autotransformers 

Table 2. Autotransformer without Tertiary or with Buried Tertiary- 9 Tests 

Test Type Test# 3</l 1</J 

Series Winding (0() Test 1 H1-X1 H1-X1 
All Other Terminals Floating 

Test 2 H2-X2 

Test 3 H3-X3 

Common Winding (OC) Test 4 X1-HOXO X1-HOXO 
All Other Terminals Floating 

Test 5 X2-HOXO 

Test 6 X3-HOXO 

Short Circuit (SC) Test 7 H1-HOXO H1-HOXO 
High (H) to Low IL) Short 
Short [X1-X2-X3]* Test 8 H2-HOXO [X1-HOXO]* 

Test 9 H3-HOXO 

* Indicates short-circuit tests where the terminals are shorted together with three sets of 
jumpers, to provide symmetry IX1-X2, X2-X3, X3-X1) OR (Y1-Y2, Y2-Y3, Y3-Y1 ). The neutral 
is not included for 3</l wye connections but may be included for 1 <P test connections. 
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Three-Winding Transformers 

Table 3. Three-Winding Transformer Table, Part 1 - 18 Tests 

3~ 3~ 3~ 3~ 
Delta- Delta- Delta- Delta-
Delta- Delta- Wye- Wye-

Test Type Test# Delta Wye Delta Wye 1~ 

HV Open Circuit (OC) Test 1 H1-H3 H1-H3 H1-H3 H1-H3 H1-H2 
All Other Terminals Floating (H1-HO) 

Test 2 H2-H1 H2-H1 H2-H1 H2-H1 

Test 3 H3-H2 H3-H2 H3-H2 H3-H2 

LV Open Circuit (OC) Test 4 X1-X3 X1-X3 X1-XO X1-XO X1-X2 
All Other Terminals Floating 

Test 5 X2-X1 X2-X1 X2-XO X2-XO 
(X1-XO) 

Test 6 X3-X2 X3-X2 X3-XO X3-XO 

Tert Open Circuit (0() Test 7 Y1-Y3 Y1-YO Y1-Y3 Y1-YO Y1-Y2 
All Other Terminals Floating 

Test 8 Y2-Y1 Y2-YO Y2-Y1 Y2-YO 
(Y1-YO) 

Test 9 Y3-Y2 Y3-YO Y3-Y2 Y3-YO 

Short Circuit (SC) Test 10 H1-H3 H1-H3 H1-H3 H1-H3 H1-HO 
High (H) to Low (L) Short 
Short [X1-X2-X3]* Test 11 H2-H1 H2-H1 H2-H1 H2-H1 [X1-X2]* 

Test 12 H3-H2 H3-H2 H3-H2 H3-H2 

Short Circuit (SC) Test 13 H1-H3 H1-H3 H1-H3 H1-H3 H1-HO 
High (H) to Tertiary (T) Short 
Short [Y1-Y2-Y3]* Test 14 H2-H1 H2-H1 H2-H1 H2-H1 [Y1-Y2]' 

Test 15 H3-H2 H3-H2 H3-H2 H3-H2 

Short Circuit (SC) Test 16 X1-X3 X1-X3 X1-XO X1-XO X1-XO 
Low (L) to Tertiary (T) Short 
Short [Y1-Y2-Y3]* Test 1 7 X2-X1 X2-X1 X2-XO X2-XO [Y1-Y2]* 

Test 18 X3-X2 X3-X2 X3-XO X3-XO 

* Indicates short-circuit tests where the terminals are shorted together with three sets of 
jumpers, to provide symmetry (X1-X2, X2-X3, X3-Xl) OR (Y1-Y2, Y2-Y3, Y3-Yl). The neutral 
is not included for 3$ wye connections but may be included for 1$ test connections. 
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Setting Up the SFRA Software 

Table 4. Three-Winding Transformer Table, Part 2 - 18 Tests 

3$ 3<jl 3<jl 3<jl 
Wye- Wye- Wye- Wye-
Wye- Wye- Delta- Delta-

Test Type Test# Wye Delta Wye Delta 

HV Open Circuit (OC) Test 1 H1-HO H1-HO H1-HO H1-HO 
All Other Terminals Floating 

Test 2 H2-HO H2-HO H2-HO H2-HO 

Test 3 H3-HO H3-HO H3-HO H3-HO 

LV Open Circuit (OC) Test 4 X1-XO X1-XO X1-X2 X1-X2 
All Other Terminals Floating 

Test 5 X2-XO X2-XO X2-X3 X2-X3 

Test 6 X3-XO X3-XO X3-X1 X3-X1 

Tert Open Circuit (OC) Test 7 Y1-YO Y1-Y2 Y1-YO Y1-Y2 
All Other Terminals Floating 

Test 8 Y2-YO Y2-Y3 Y2-YO Y2-Y3 

Test 9 Y3-YO Y3-Y1 Y3-YO Y3-Y1 

Short Circuit (SC) Test 10 H1-HO Hl-HO H1-HO H1-HO 
High (H) to Low (L) 

Test 11 H2-HO H2-HO H2-HO H2-HO Short [X1-X2-X3]' 

Test 12 H3-HO H3-HO H3-HO H3-HO 

Short Circuit (SC) Test 13 H1-HO H1-HO H1-HO Hl-HO 
High (H) to Tertiary (T) 

Test 14 H2-HO H2-HO H2-HO H2-HO Short [Y1-Y2-Y3]' 

Test 15 H3-HO H3-HO H3-HO H3-HO 

Short Circuit (SC) Test 16 X1-XO Xl-XO X1-X2 X1-X2 
Low (L) to Tertiary (T) 

Test 17 X2-XO X2-XO X2-X3 X2-X3 Short [Y1-Y2-Y3]' 

Test 18 X3-XO X3-XO X3-X1 X3-X1 

' lnd1cates short-c~rcu1t tests where the termmals are shorted together with three sets of jumpers, 
to provide symmetry (X1-X2, X2-X3, X3-X1) OR (Y1-Y2, Y2-Y3, Y3-Yl). The neutral is not 
included for wye connections. 

Setting Up the SFRA Software 

M5300 
Turn on the power switch located on the front of the M5300. 

The M5300 SFRA software should start automatically. If your system has been modified, 
double-click the SFRA icon or select Start> All Programs> Doble Engineering> SFRA. 
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M5200 or M5400 and PC 
1. Power on the M5200 or M5400 without connecting it to the PC. 

The power light should come on. Both LEOs come on, then go out, and finally 
the System OK LED comes on. 

Make sure the SFRA software is installed on your PC's hard drive, not a network 
drive. 

2. Turn off wireless connections and disable firewalls and antivirus software. 

These restrictions do not apply if you wish to use the software in Viewer mode 
only, without communicating with an M5200 or M5400. 

3. Double-click the SFRA desktop icon or select Start> Programs> Doble 
Engineering> SFRA to start the software. 

4. When the Connect To Instrument dialog box appears (Figure 3), connect the 
M5200 or M5400 to the PC, using either the USB or Ethernet cable. 

Earlier models were supplied with an Ethernet cable and a separate crossover 
adapter, which must be used for the instrument to function. Later models have 
the crossover built into the Ethernet cable. 

-~ " 0 ~ ~ -~~ ""' ~ ~ ,~~~,~~ " -"~-= --~- ~ ~- -~--"~ ~~ g:::""'} 
Connect to Instrument I%Zt 

Turn on Instrument for at least 20 seconds. 
Attach communication cable, 
Wail: for system ready light to turn on, test light off, 

Press 'Yes' to start Instrument connection. 
Press 'No' to use viewer only. 

Yes No 

Figure 3. Connect to Instrument Dialog Box 

5. Click Yes to connect to the M5200 or M5400 only if: 

• The M5200 or M5400 has been powered on. 

• The System OK LED is on and the Test In Progress LED is off. 

• The instrument is connected to the PC with a USB or crossover Ethernet 
cable. 

The Select Instrument dialog box appears. The upper pane displays instruments 
located on the network or is blank if none were found. 

If the PC is unable to locate the instrument: 

a. Check your connection to the instrument and your IP address (if using 
Ethernet). 

b. Click Continue Searching For Instruments. 

You also have the option to use Viewer mode or exit SFRA. 
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Running a Test 

6. When instruments appear, select the desired instrument. 

7. Click Select Instrument. 

If the PC can communicate with the instrument but cannot transfer data, the 
Connection Error dialog box appears. This can occur with a faulty cable 
connection or if a firewall or antivirus software is preventing communication. 

If the PC is unable to communicate with the M5200 or M5400, the Connection 
Not Attempted dialog box appears. 

Running a Test 
You can perform a test only with an M5300 or with a PC connected to an M5200 or 
M5400; it is not possible to perform a test in Viewer mode without an instrument. 

To run a test: 

Select Apparatus 
1. Click Select Apparatus in the Apparatus And Test pane on the left. 

2. In the Apparatus Selection dialog box, select the transformer to be tested, the 
Location, the Test Organization, and the Test Equipment. 

3. Click OK. 

Select Test 
4. Click Select Test in the Apparatus and Test pane. 

5. In the Test Selection dialog box, select the desired test. 

6. Click OK. 

7. In the Apparatus and Test pane, select the purpose and oil level conditions from 
the dropdown menus. 

Start Test 
8. Click Start Test, press F2, or select Test I nit> Start Test. 

9. In the Test Details dialog box, enter the location of the red and black test leads. 

Trace Name is a combination of the red and black lead locations. If no test 
template has been selected, the fields are blank. 

10. Click Run Test. 

The minimum details required for each test are: 

• Manufacturer, serial number, location 

• HV/LV!TV, MVA, impedance 

• LTC and DETC ranges and nominal position 

• LTC and DETC positions during test 

• Red and black lead locations 

• Bushings grounded 

• Bushings shorted 
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Typical Results 
Correct use of the instrument and test leads will result in measurements similar to those 
in Figure 4 and Figure 5. These plots show results for all three phases of a transformer. 
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Figure 4. Typical HV Delta Winding Response 
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Figure 5. Typical HV Wye Winding Response 
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